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Except as provided in writing signed by an officer to Beckman Coulter, Inc., this system and any related 
documentation are provided “as is” without warranty of any kind, expressed or implied, including that the system is 
“error free.” This information is presented in good faith, but Beckman Coulter, Inc. does not warrant, guarantee, or 
make any representations regarding the use or the results of the use of this system and related documentation in terms 
of correctness, accuracy, reliability, currentness, omissions, or otherwise. The entire risk as to the use, results, and 
performance of this system and related documentation is assumed by the user.
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fitness for a particular purpose, nor is freedom from any patent owned by Beckman Coulter, Inc. or by others to be 
inferred.

LIMITATIONS OF LIABILITY
Beckman Coulter, Inc. shall not be liable, to any extent whatsoever, for any damages resulting from or arising out of 
the use or performance of this system and related documentation or the procedures specified in this manual, 
regardless of foreseeability or the form of action, whether in contract, tort (including negligence), breach of warranty, 
strict liability or otherwise, and including but not limited to damages resulting from loss of data, loss of anticipated 
profits, or any special, indirect, incidental or consequential damages. In no event shall Beckman Coulter, Inc.’s 
liability to the user exceed the amount paid by the user to Beckman Coulter, Inc. hereunder. The user assumes full 
responsibility for the results obtained from the use of this system and related documentation and for application of 
such results.
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Business Machines Corporation in the United States, other countries, or both. Pentium is a registered trademark of 
Intel Corporation. Adobe, Acrobat, and Postscript are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. All other trademarks appearing in this manual are the 
property of their respective owners.

Copyright 2004 by Beckman Coulter, Inc. All rights reserved. No part of this publication may be reproduced, 
distributed, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, or stored in a database or retrieval system, without the prior written permission of Beckman Coulter, Inc.
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Warranty and Returned Goods Requirements
All standard Beckman Coulter, Inc. policies governing returned goods apply to this 
product. Subject to the exceptions and upon the conditions stated below, the Company 
warrants that the products sold under this sales agreement shall be free from defects in 
workmanship and materials for one year after delivery of the products to the original 
Purchaser by the Company, and if any such product should prove to be defective 
within such one year period, the Company agrees, at its option, either (1) to correct by 
repair or at the Company’s election by replacement, any such defective product 
provided that investigation and factory inspection discloses that such defect 
developed under normal and proper use, or (2) to refund the purchase price. The 
exceptions and conditions mentioned above are as follows:

a. Components or accessories manufactured by the Company which by their 
nature are not intended to and will not function for one year are warranted 
only to reasonable service for a reasonable time. What constitutes a 
reasonable time and a reasonable service shall be determined solely by the 
Company. A complete list of such components and accessories is maintained 
at the factory.

b. The Company makes no warranty with respect to components or accessories 
not manufactured by it. In the event of defect in any such component or 
accessory, the Company will give reasonable assistance to Purchaser in 
obtaining from the manufacturer’s own warranty.

c. Any product claimed to be defective must, if required by the Company, be 
returned to the factory, transportation charges prepaid, and will be returned 
to Purchaser with transportation charges collect unless the product is found 
to be defective, in which case the product must be properly decontaminated 
of any chemical, biological, or radioactive hazardous material.

d. The Company shall be released from all obligations under all warranties, 
either expressed or implied, if any product covered hereby is repaired or 
modified by persons other than its own authorized service personnel, unless 
such repair by others is made with the written consent of the Company.

e. If the product is a reagent or the like, it is warranted only to conform to the 
quantity and content and for the period (but not in excess of one year) stated 
on the label at the time of delivery.

It is expressly agreed that the above warranty shall be in lieu of all warranties of 
fitness and of the warranty of merchantability, and that the company shall have no 
liability for special or consequential damages of any kind or from any cause 
whatsoever arising out of the manufacture, use, sale, handling, repair, maintenance, or 
replacement of any of the products sold under the sales agreement.

Representatives and warranties made by any person, including dealers and 
representatives of the Company, which are consistent or in conflict with the terms of 
this warranty, shall not be binding upon the Company unless reduced in writing and 
approved by an expressly authorized officer of the Company.

Parts replaced during the warranty period are warranted to the end of the instrument 
warranty.

Note:  Performance characteristics and specifications are only warranted when 
Beckman Coulter replacement parts are used.
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Safety Information

All Warnings and Cautions in this document include an exclamation point, a lightning 
bolt, or a light burst symbol framed within a triangle. Please pay special attention to 
the specific safety information associated with these symbols. 

WARNING: If the equipment is used in a manner not specified by 
Beckman Coulter, Inc., the protection provided by the equipment may be 
impaired.

Warning and Caution Definitions
The exclamation point symbol is an international symbol which serves as a reminder 
that all safety instructions should be read and understood before installation, use, 
maintenance, and servicing is attempted.

When this symbol is displayed in this manual, pay special attention to the specific 
safety information associated with the symbol.

WARNING
A WARNING calls attention to a condition or possible situation that 
could cause injury to the operator.

CAUTION
A CAUTION calls attention to a condition or possible situation that could 
damage or destroy the product or the operator’s work.
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Warnings and Cautions Found in this Manual
Please read and observe all cautions and instructions. Remember, the most important 
key to safety is to use Multimode Detection Software with care.

The WARNINGs and CAUTIONs found within this document are listed below.

WARNING: If the equipment is used in a manner not specified by 
Beckman Coulter, Inc., the protection provided by the equipment may be 
impaired.
CAUTION: Shake low density plates, such as 6- or 48-well plates, at low 
speed only. Shaking low density plates at higher speeds may cause 
liquid in wells to spill.
CAUTION: The plate height configured must not be less than that of the 
actual plate. Doing so may cause the DTX 880 optics transport to collide 
with the plate during a Read Height Optimization.
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1 Installing, Setting Up, and 
Using the Software

1.1 Overview
Multimode Detection Software configures and controls all measurement protocols 
and operations performed by the DTX 800 and DTX 880 Multimode Detectors. 
Absorbance, glow luminescence, fluorescence intensity (top and bottom), 
fluorescence polarization, and time-resolved fluorescence (TRF) measurements are 
all supported. The measurement methods available to users depend on the capabilities 
of the instrument being controlled. Measurement results are easily exported and may 
be evaluated with an external application such as Microsoft® Excel.

The simple interface divides the main window into three basic sections, which 
provide easy access to system functionality. Most operations use a wizard-type 
interface to efficiently guide the task being performed.

This user’s manual provides comprehensive coverage of Multimode Detection 
Software functionality, including:

• Setting Up and Controlling Instruments (Chapter 2).

• Creating and Editing Detection Methods (Chapter 3).

• Creating and Editing Labware (Chapter 4).

• Defining, Editing, and Running Protocols (Chapter 5).

• Viewing Measurement Results (Chapter 6).

This chapter introduces users to the software and provides instructions for:

• Using Multimode Detection Software (Section 1.2).

• Installing Multimode Detection Software (Section 1.3).

• Setting Up Multimode Detection Software (Section 1.4).
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1.2 Using Multimode Detection Software
Multimode Detection Software uses a simple interface that divides the main window 
into three basic sections: navigation pane, toolbar, and selection and configuration 
pane (Figure 1-1). The interface includes easy access to the five modules that provide 
system functionality and a comprehensive, context-sensitive online help system. 

This section covers:

• Launching the Software (Section 1.2.1).

• Using the Software Interface (Section 1.2.2).

• Accessing Online Help (Section 1.2.3).

1.2.1 Launching the Software
To launch Multimode Detection Software:

From the Windows® Start menu, choose Programs>Beckman Coulter, 
Inc>Multimode Detection Software>Multimode Detection Software. 
Multimode Detection Software appears (Figure 1-1).

Note:  If Multimode Detection Software is not found in the Start menu, the 
software may have been installed for a single user account on the system instead 
of all accounts. Check with the site system administrator or login to the user 
account with permission to access the software. Refer to Section 1.3.2, Using the 
Setup Program to Install the Software, for more information about installing the 
software for a single or multiple user accounts.

Figure 1-1.  Multimode Detection Software main window

Toolbar

Selection and 
configuration pane

Navigation 
pane

Modules
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1.2.2 Using the Software Interface
Multimode Detection Software uses a simple interface that is divided into three basic 
sections:

• Navigation pane (refer to Section 1.2.2.1, About the Navigation Pane).

• Toolbar (refer to Section 1.2.2.2, About the Toolbar).

• Selection and configuration pane (refer to Section 1.2.2.3, About the 
Selection and Configuration Pane).

The navigation pane provides access to the five modules that provide the majority of 
the functionality built into the software. The options available in the toolbar and 
selection and configuration pane are determined by the module currently selected in 
the navigation pane.

1.2.2.1 About the Navigation Pane
The navigation pane is the narrow pane on the left of the Multimode Detection 
Software window (Figure 1-1). Use the navigation pane to switch between modules:

• Protocols — opens the Protocol Selection List and provides the ability to 
define, run, edit, copy, delete, and print measurement protocols (refer to 
Chapter 5, Defining, Editing, and Running Protocols).

• Detection Methods — opens the Detection Method Selection List and 
provides the ability to create, edit, copy, and delete detection methods (refer 
to Chapter 3, Creating and Editing Detection Methods).

• Labware — opens the Labware Selection List and provides the ability to 
create, edit, optimize, copy, and delete labware types (refer to Chapter 4, 
Creating and Editing Labware).

• Instruments — opens the Instrument Selection List and provides the 
ability to manually control instrument functions, such as shaking, and 
configure communications settings and filter slides (refer to Chapter 2, 
Setting Up and Controlling Instruments).

• Software Settings — configures software settings, including system 
language, print options, default simulated data files, and the directory where 
measurement results are saved (refer to Section 1.4.2, Configuring Software 
Settings).

1.2.2.2 About the Toolbar
The toolbar provides easy access to common software functions. Functions available 
in the toolbar are specific to the module chosen in the navigation pane. For example, 
Optimize Labware is only available when the Labware module is active.

1.2.2.3 About the Selection and Configuration Pane
The selection and configuration pane is the large pane to the right of the navigation 
pane. Options available in this pane change depending on which module is currently 
selected in the navigation pane. For example, when Protocols is selected, the 
Protocol Selection List is displayed, which provides access to configured protocols 
and functionality specific to the Protocols module.
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1.2.3 Accessing Online Help
Multimode Detection Software contains a detailed online help system that covers 
defining and editing labware, detection methods, and protocols, performing 
measurements, and exporting measurement results. The online help is context 
sensitive, which provides instant access to help for the active screen.

To access online help:

Press F1 at any time to display online help for the active screen (Figure 1-2).

OR

From the Help menu, choose Help to display the table of contents.

Figure 1-2.  Using online help 
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1.3 Installing Multimode Detection Software
Installing Multimode Detection Software requires:

• Meeting System Requirements (Section 1.3.1).

• Using the Setup Program to Install the Software (Section 1.3.2).

1.3.1 Meeting System Requirements
To install and use Multimode Detection Software successfully, the host computer 
must meet the minimum system requirements listed in Table 1-1. Where relevant, 
Table 1-1 also lists recommended specifications.

1.3.2 Using the Setup Program to Install the 
Software

The setup program on the installation CD installs all of the components required to 
run Multimode Detection Software.

Note:  The setup program also provides the ability to repair the software installation 
or remove (uninstall) the software from the host computer (refer to Section 1.3.3, 
Repairing or Removing the Multimode Detection Software Installation).

To install Multimode Detection Software:

1. Exit all open Windows programs before running the setup program.

2. Make sure the current user account has Administrator privileges. Accounts with 
Standard or Restricted access are not permitted to run the setup program. Contact 
the site system administrator for more information about account privileges.

Table 1-1.  Host computer System Requirements
Component Minimum Requirements

CPU Pentium® II 300 Mhz
RAM 128 MB minimum

256 MB recommended
Hard Drive 150 MB free space
CD-ROM Drive 4X
Monitor 640x480 resolution
Keyboard 101 key
Mouse IBM® compatible
Serial Port 1 free serial port
Operating Systems Windows NT® 4 (Service Pack 6a)

Windows® 2000
Windows® XP

Operating System Languages English (U.S.), German
Web Browser Internet Explorer 5.01 or later
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3. Insert the Multimode Detection Software installation CD into the CD-ROM 
drive. After a few seconds, Language Options appears (Figure 1-3).

Note:  If Language Options does not appear automatically within a few 
seconds of inserting the CD into the drive, use Windows Explorer to browse to 
the CD-ROM drive and run MultimodeDetectionSoftwareInstall.exe.

Figure 1-3.  Installer Language Options

4. If installing the software on a German language version of Windows, choose 
German Language Operating System. This ensures that all software screens 
are displayed correctly when German is set as the system language used in the 
Multimode Detection Software interface.

5. Choose Install to start the installation. Multimode Detection Software 
Installation appears (Figure 1-4).

Figure 1-4.  Starting the software installation
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6. Choose OK to start the installation. The Multimode Detection Software setup 
wizard appears (Figure 1-5).

Figure 1-5.  Setup wizard

7. Choose Next to continue the installation. Select Installation Folder appears 
(Figure 1-6).

Figure 1-6.  Selecting installation options

Installation 
folder
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8. Choose Browse to select a different installation folder for the software, if 
desired.

9. Choose Disk Cost to view the free space available on all hard drives installed in 
the computer, if desired.

10. Select Everyone to allow all user accounts configured on the computer to 
access and use the software. Everyone should be selected when more than one 
user will be using the software to perform measurements.

OR

Select Just Me to allow only the user account currently logged in to access and 
use the software.

Note:  Only user accounts with Administrator or Standard access may use 
Multimode Detection Software. User accounts with Restricted access do not have 
access to the software.

11. Choose Next to continue the installation.

OR

Choose Back to return to the previous screen in the setup wizard.

OR

Choose Cancel to close the setup wizard without installing the software.

12. Follow the remaining instructions in the setup wizard to complete the software 
installation. When installation is complete, communications and system settings 
may be configured (refer to Section 1.4, Setting Up Multimode Detection 
Software).
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1.3.3 Repairing or Removing the Multimode 
Detection Software Installation

Along with performing the initial Multimode Detection Software installation, the 
setup program also provides the ability to:

• Repair the installation if required software components or files are missing 
or damaged. Try repairing the installation if the software will not open or 
does not run correctly.

• Remove (uninstall) Multimode Detection Software from the host computer. 

Note: Multimode Detection Software may also be removed from the 
computer using the Add/Remove Programs control panel in Windows®.

To repair or remove the software:

1. Exit all open Windows programs before running the setup program.

2. Make sure the current user account has Administrator privileges. Accounts with 
Standard or Restricted access are not permitted to run Setup. Contact the site 
system administrator for more information about account privileges.

3. Insert the Multimode Detection Software installation CD into the CD-ROM 
drive. After a few seconds, Language Options appears.

Note:  If Language Options does not appear automatically within a few 
seconds of inserting the CD into the drive, use Windows Explorer to browse to 
the CD-ROM drive and run MultimodeDetectionSoftwareInstall.exe.

4. If repairing software installed on a German language version of Windows, 
choose German Language Operating System. This ensures that all software 
screens are displayed correctly when German is set as the system language used 
in the Multimode Detection Software interface.

5. In Language Options, choose Install to start the installation. Multimode 
Detection Software Installation appears.

6. Choose OK to continue. The Multimode Detection Software setup wizard 
appears.

7. Choose Next to continue. Options to repair or remove the software appear 
(Figure 1-7).
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Figure 1-7.  Setup wizard — repair or remove the software installation

8. Select Repair Multimode Detection Software to search for and 
automatically reinstall any missing or damaged files required to run the software.

OR

Select Remove Multimode Detection Software to remove the application 
and support files from the host computer.

Note:  When removing the software, only files installed by the setup program 
during the initial installation are removed. Files created after the installation, 
such as exported measurement results and labware, detection method, and 
protocol definitions, are not removed. Measurement results files may still be 
viewed after the software is uninstalled. All file types may be copied, archived, 
or manually deleted.

9. Choose Finish to perform the selected action.

OR

Choose Cancel to close the setup wizard without repairing or removing the 
software.
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1.4 Setting Up Multimode Detection Software
After installing the software and physically connecting the instrument to a serial port 
on the host computer, communications and software settings must be set up.

Setting up the software includes:

• Configuring Communication Settings (Section 1.4.1).

• Configuring Software Settings (Section 1.4.2).

To set up Multimode Detection Software:

1. From the Windows® Start menu, choose Programs>Beckman Coulter, 
Inc>Multimode Detection Software>Multimode Detection Software. 
Multimode Detection Software appears (Figure 1-8).

Note:  If Multimode Detection Software is not found in the Start menu, the 
software may have been installed for a single user account on the system instead 
of all accounts. Check with the site system administrator or login to the user 
account with permission to access the software. Refer to Section 1.3.2, Using the 
Setup Program to Install the Software, for more information about installing the 
software for a single or multiple user accounts.

Figure 1-8.  Multimode Detection Software main screen
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2. If the Protocol Selection List (Figure 1-8) appears immediately, the instrument 
was automatically detected by the software. Proceed to Section 1.4.2, 
Configuring Software Settings, to configure system settings.

OR

If Warning appears (Figure 1-9), the instrument was not detected by the 
software. Choose OK to work in simulation mode until the communications 
settings are configured properly.

Figure 1-9.  Warning — Instrument is not connected

3. If the instrument was not detected, configure the communications settings 
following the steps in Section 1.4.1, Configuring Communication Settings.

4. Configure system settings, such as language and printing options, following the 
steps in Section 1.4.2, Configuring Software Settings.
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1.4.1 Configuring Communication Settings
After physically connecting the instrument to a serial communications port on the 
host computer, the selected serial port and communications speed must be configured 
correctly before Multimode Detection Software can control instrument operations. 
Communications settings are configured in Instrument Settings.

Before communications with an instrument are configured, a simulated instrument 
(Serial # 0000) appears in the Instrument Selection List (Figure 1-10). When 
communications are configured correctly and the instrument is detected by the 
software, the simulated instrument is replaced in the list by the connected instrument.

To configure communications settings:

1. From the navigation pane, choose Instruments. The Instrument Selection 
List appears (Figure 1-10).

Figure 1-10.  Instrument Selection List with simulated instrument selected

Simulated 
instrument
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2. From the toolbar, choose Instrument Settings. Instrument Settings appears 
(Figure 1-11).

OR

From the Actions menu, choose Instrument Settings.

Figure 1-11.  Configuring communications settings

3. Select Basic Settings to display the Basic Settings tab, if necessary.

4. In Port, select the serial communications port on the host computer that connects 
to the instrument.

5. In Baudrate, select 38400. 

6. Choose Apply to detect the instrument. When the instrument is detected, the 
instrument information fields are autopopulated with information about the 
connected instrument. Refer to Table 2-1 for more information about each field.

7. Choose OK to close Instrument Settings.

Instrument 
information fields
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1.4.2 Configuring Software Settings
Multimode Detection Software can be customized using the options available in 
Software Settings (Figure 1-12). Use the tabs in Software Settings to configure 
the system language, printout options, default simulated data files, and directory 
where measurement results are stored.

To configure Software Settings:

1. From the navigation pane, choose Software Settings. Software Settings 
appears (Figure 1-12).

Figure 1-12.  Configuring Software Settings

2. Configure the settings in the desired tab(s):

• Setting the System Language (Section 1.4.2.1).

• Configuring Print Settings (Section 1.4.2.2).

• Choosing Simulated Data Files (Section 1.4.2.3).

• Choosing the Directory Where Measurement Results are Saved 
(Section 1.4.2.4).

Software 
settings
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1.4.2.1 Setting the System Language
English is set as the default system language when Multimode Detection Software is 
installed, even when German Language Operating System is selected during 
installation (refer to Section 1.3.2, Using the Setup Program to Install the Software). 
The system language may be changed in the Language tab (Figure 1-13).

Figure 1-13.  Choosing the software interface language

To change the system language:

1. Choose the Language tab. All available languages are listed, with the current 
system language highlighted (Figure 1-13).

2. Select the desired language.

3. Choose Apply. The system language changes to the language selected.

Available 
languages
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1.4.2.2 Configuring Print Settings
Measurement results and protocol configurations may be printed. Printing 
parameters, such as headers and footers are configured in the Print Settings tab 
(Figure 1-14).

Figure 1-14.  Configuring Print Settings

To configure print settings:

1. Choose the Print Settings tab. Print Settings appears (Figure 1-14).

2. In Print Header, enter text for each header Line, as desired. Header lines may 
be left blank.

3. In Footer, enter text for the Footer and Comment, as desired. The comment 
appears on printed pages below the footer. The footer and comment may be left 
blank.

4. In Print Options, select Print Preview to preview the page layout onscreen 
each time a protocol or measurement results are printed.

5. In Print Options, choose Show printer settings to display printing options 
each time a protocol or measurement results are printed. 

6. Choose Apply to save the new print settings.
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1.4.2.3 Choosing Simulated Data Files
Protocols may be run in simulation mode, which allows the protocol configuration to 
be tested using simulated data before performing the protocol on actual samples. In 
simulation mode, all features for the instrument type currently selected in the 
Instrument Selection List are available, but measurement results are either 
randomly generated by the software or read from a data file.

Use Simulated Data to choose the default data files for simulated absorbance, 
luminescence, and fluorescence measurements (Figure 1-15).

Figure 1-15.  Choosing the Simulated Data files

To choose different simulated data files:

1. Choose the Simulated Data tab. Simulated Data appears (Figure 1-15).

2. In the desired field, enter the full path to the new simulated data file; for example, 
c:\program files\beckman coulter, inc\multimode detection 
software\templates\DefaultDataFile.dat. Any data file with the .dat 
extension may be selected, including prior measurement results. Proceed to 
step 5.

OR

Choose the Browse button next to the desired measurement type. Open 
appears.

Note:  Simulated data files are used when the number of measurement points in 
the simulated protocol run is the same as those present in the data file. When the 
number of measurement points is different, the software generates random data.

3. In Open, browse to desired data file. Any data file with the .dat extension may 
be selected, including prior measurement results.

Browse for 
desired data files
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4. Choose Open to select the data file and return to Software Settings.

OR

Choose Cancel to close Open without selecting a different data file.

5. Repeat steps 2 – 4 for each simulated data file desired to change.

6. Choose Apply to set the new default data file(s).

1.4.2.4 Choosing the Directory Where Measurement 
Results are Saved

All exported measurement results files, regardless of format, are saved in a single 
directory. The default storage directory is c:\program files\beckman coulter, inc\ 
multimode detection software\data\. Use Directory Settings to change the storage 
directory, if desired (Figure 1-16). 

Figure 1-16.  Choosing the directory where data is saved

To choose a different storage directory:

1. In Data Directory, enter the complete path of the desired storage directory; for 
example, C:\documents\measurement results\DTX 880\MyResults\. 
Proceed to step 4.

Choose Browse for a directory. Open appears.

2. In Open, browse to desired directory.

Browse for desired 
storage directory
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3. Choose Open to select the directory and return to Output Settings.

OR

Choose Cancel to close Open without selecting a new storage directory.

4. Choose Apply to set the new storage directory.
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2 Setting Up and Controlling 
Instruments

2.1 Overview
Before defining measurement protocols, detection methods, and labware, or running 
protocols on an instrument using Multimode Detection Software, the instrument must 
be set up and configured. All configured instruments are listed separately in the 
Instrument Selection List.

The Instrument Selection List contains quick access to control common instrument 
functions, such as loading and ejecting the plate carrier, and to configure instrument 
settings.

Use the Instrument Selection List for:

• Controlling Instrument Functions (Section 2.2).

• Configuring Instrument Settings (Section 2.3).
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To configure and manually control instruments:

From the navigation pane, choose Instrument. The Instrument Selection List 
appears (Figure 2-1). 

Figure 2-1.  Instrument Selection List

All instruments that have been connected to the host computer and configured in the 
software are displayed in the Instrument Selection List. When an instrument not 
currently connected to the computer is selected, the software automatically enters 
simulation mode (refer to Section 2.2.5, Enabling Simulation Mode). This allows 
protocols, detection methods, and labware to be defined, edited, and tested for the 
selected instrument even though it is not physically connected to the host computer.
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2.2 Controlling Instrument Functions
Many common instrument functions, such as ejecting and loading the plate carrier 
and initializing the instrument, can be performed directly from the Instrument 
Selection List using the buttons on the toolbar. 

Controlling instrument functions includes:

• Ejecting the Plate Carrier (Section 2.2.1).

• Loading the Plate Carrier (Section 2.2.2).

• Initializing the Instrument (Section 2.2.3).

• Connecting to the Instrument (Section 2.2.4).

• Enabling Simulation Mode (Section 2.2.5).

2.2.1 Ejecting the Plate Carrier
Eject the plate carrier moves the plate carrier outside the instrument to allow access 
for placement or removal of a microplate.

To eject the plate carrier:

1. In the Instrument Selection List, select the desired instrument (Figure 2-1).

2. From the toolbar, choose Eject the plate carrier.

OR

From the Actions menu, choose Eject the plate carrier.

OR

Right-click on the desired instrument and choose Eject the plate carrier from 
the menu that appears.

2.2.2 Loading the Plate Carrier
Load the plate carrier retracts the plate carrier and microplate back inside the 
instrument in preparation of performing a measurement.

To load the plate carrier:

1. In the Instrument Selection List, select the desired instrument (Figure 2-1).

2. From the toolbar, choose Load the plate carrier.

OR

From the Actions menu, choose Load the plate carrier.

OR

Right-click on the desired instrument and choose Load the plate carrier from 
the menu that appears.
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2.2.3 Initializing the Instrument
Initializing the instrument moves the optics and microplate transports to home 
positions. Each time the instrument is turned on, an initialization procedure is 
automatically performed. If necessary, the instrument may be initialized manually; for 
example, after an emergency stop has been performed (refer to the DTX 800/880 
Multimode Detectors User’s Manual, Section 1.3.1.1, Performing an Emergency 
Stop).

Note:  When a hardware error occurs, turning the instrument off and on is 
recommended. The instrument initializes automatically on power up, and will not 
require manually initializing the instrument using the software.

To manually initialize the instrument:

1. In the Instrument Selection List, select the desired instrument (Figure 2-1).

2. From the toolbar, choose Initialize the instrument.

OR

From the Actions menu, choose Initialize the instrument.

OR

Right-click on the desired instrument and choose Initialize the instrument 
from the menu that appears.

2.2.4 Connecting to the Instrument
When Multimode Detection Software is launched, it automatically connects to the 
instrument or starts in simulation mode if no instrument is detected. The connection 
to the instrument may be established manually after physically connecting a different 
instrument to the computer, or when switching from simulation mode (refer to 
Section 2.2.5, Enabling Simulation Mode).

To connect to the instrument:

1. In the Instrument Selection List, select the desired instrument (Figure 2-1).

2. From the toolbar, choose Connect to the instrument. The button remains 
depressed while the instrument is connected and not in simulation mode.

OR

From the Actions menu, choose Connect to the instrument.

OR

Right-click on the desired instrument and choose Connect to the instrument 
from the menu that appears.
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2.2.5 Enabling Simulation Mode
Multimode Detection Software can operate in simulation mode whether or not an 
instrument is connected. Simulation mode enables all features supported by the 
instrument currently selected in the Instrument Selection List, but measurement 
results are randomly generated by the software or read from a file. Refer to Section 
1.4.2.3, Choosing Simulated Data Files, for more information about selecting 
simulated data files.

To enable simulation mode:

1. In the Instrument Selection List, choose the desired instrument.

2. From the toolbar, choose Simulate the current instrument. The button 
remains depressed while the instrument is in simulation mode.

OR

From the Actions menu, choose Simulate the current instrument.

OR

Right-click on the desired instrument and choose Simulate the current 
instrument from the menu that appears.
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2.3 Configuring Instrument Settings
Communication settings and filter slides for the instrument are configured in 
Instrument Settings. Configuring the instrument in Instrument Settings informs 
Multimode Detection Software about the instrument, such as the communication 
speed and port used, and the configuration of filter slides and individual filters. 
Instrument features, such as microplate shaking, may also be controlled manually.

To configure instrument settings:

1. Select the desired instrument in Instrument Selection List.

2. From the toolbar, choose Instrument Settings. Instrument Settings appears.

OR

From the Actions menu, choose Instrument Settings.

OR

Right-click on the desired instrument and choose Instrument Settings from 
the menu that appears.

3. Configure instrument settings on the three tabs as described in the following 
sections:

• Configuring Basic Instrument Settings (Section 2.3.1).

• Defining and Editing Filter Slides (Section 2.3.2).

• Manually Controlling the Instrument (Section 2.3.3).

2.3.1 Configuring Basic Instrument Settings
The Basic Settings tab (Figure 2-2) contains information about the connection from 
the instrument to the operating computer, as well as identifying information about the 
instrument. The Port and Baudrate must be configured correctly to enable 
Multimode Detection Software to communicate with the instrument.

Figure 2-2.  Instrument Settings — Basic Settings

Instrument 
information fields
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To configure basic instrument settings:

1. In Instrument Settings, select Basic Settings to display the Basic Settings 
tab, if necessary.

2. In Port, select the serial communications port on the host computer that connects 
to the instrument.

3. In Baudrate, select 38400. 

4. Choose Apply to detect the instrument. When the instrument is detected, the 
instrument information fields are autopopulated with information about the 
connected instrument. Refer to Table 2-1 for more information about each field.

Table 2-1.  Basic Settings Read-Only Fields
Field Description

Instrument Name The model of the instrument.
Serial Number The serial number of the instrument.
Instrument Type A numerical code used by the software to 

identify the instrument type.
Firmware Version The version of firmware loaded for the 

instrument.
PIC FW Version The version of firmware loaded for the 

PIC processor of the instrument.
Features The types of measurements the 

instrument is capable of performing. 
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2.3.2 Defining and Editing Filter Slides
The Filter Slides tab (Figure 2-3) is used to add, remove, and configure filter slides 
and the filters installed on a filter slide.

Filters used to perform measurements are mounted on two types of interchangeable 
slides. One slide is reserved for excitation filters used in absorbance and fluorescence 
measurements; the other is used for emission filters used in fluorescence and some 
luminescence measurements. Excitation and emission filter slides are different sizes 
to prevent them from being installed in the incorrect position. Each slide can hold up 
to six filters. 

When a slide is exchanged, an identification code built into the slide allows the 
Multimode Detection Software to recognize the new slide and filter configuration. 
When a slide with a new configuration is inserted, or the filters on a slide change, the 
slide must be configured in the Filter Slides tab. Up to 31 excitation filter slides and 
31 emission filter slides may be stored in Multimode Detection Software at one time.

Note:  Refer to the DTX 800/880 Multimode Detectors User’s Manual, Section 1.3.2, 
Exchanging Filter Slides and Individual Filters, for information on installing filters 
and filter slides.

Figure 2-3.  Instrument Settings — Filter Slides

2.3.2.1 Adding Filter Slides
When a new filter slide is used with the instrument for the first time, it must be added 
so Multimode Detection Software can identify the slide and filter configuration.

To add filter slides:

1. Select the type of filter slide to add: Excitation or Emission. The list of filter 
slides displays all slides of the selected type currently stored in memory.

2. Choose Add Slide. A new filter slide is added to the list of filter slides.

3. Configure the slide following the steps in Section 2.3.2.2, Configuring Filter 
Slides.
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2.3.2.2 Configuring Filter Slides 
The filter slide configuration includes a name and ID for the slide and information 
about the filters installed on the slide. When a new slide is added, or the filter 
configuration on a slide changes, the slide must be configured.

To configure a filter slide:

1. Select the type of filter slide to configure: Excitation or Emission. The list of 
filter slides displays all configured slides of the selected type.

2. Select the desired filter slide to configure from the list. Filter Slide Properties 
displays information about the selected slide (Figure 2-3).

3. In Slide ID, enter the identification number printed on the slide.

4. In Slide Name, enter a name to identify the filter slide.

5. In the list of filter slides, click the + to the left of the filter slide name to display 
the list of filters installed on the slide.

6. Select a filter to configure. Filter Properties for the selected filter is displayed 
on the right side of the screen (Figure 2-4).

Figure 2-4.  Configuring filter properties

7. In Wavelength, enter the wavelength of the filter.

8. Click in the Technique(s) field and then click the down arrow to display a list 
of the available techniques. 

9. Select all techniques for which the filter applies. The filter can be used only for 
measurements of the selected technique type(s). When techniques are selected, 
the read-only Installed field displays Yes. When No is displayed, no techniques 
are selected and the filter may not be used in any techniques.

DTX 880 — Select Polarization only for filter positions where a 
polarization filter is installed.

Selected filter

Properties of 
selected filter
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10. In Name, enter a name for the selected filter. Filter names default to the 
wavelength entered, but may be renamed as desired.

11. In Bandwidth, enter the bandwidth in nanometers of the selected filter.

12. Repeat steps 6 to 11 to configure additional filters on the slide.

2.3.2.3 Removing Filter Slides
If a filter slide is no longer used with an instrument, it can be removed from 
Multimode Detection Software.

To remove a filter slide:

1. Select the type of filter slide to remove: Excitation or Emission. The list of 
filter slides displays all slides of the selected type.

2. Select the desired filter slide to remove from the list. Filter Slide Properties 
displays information about the selected slide.

3. Choose Remove Slide. The selected filter slide is removed from the list.

2.3.2.4 Exporting and Importing Filter Slides
Information for all excitation and emission filter slides configured for the instrument 
can be exported to an XML file and imported to restore that configuration or share the 
filter slide configuration with another instrument. Importing the filter slide 
configuration from an XML file replaces the current configuration for all filter slides 
with the configuration from the file.

To export all filter slides:

1. Choose Export Slides. Save As appears.

2. In Save As, select the desired directory and enter a file name.

3. Choose Save. Slide information is saved as an .xml file with the specified path 
and file name.

To import all filter slides from a previously exported file:

1. Choose Import Slides. Open appears.

2. In Open, browse to and select the desired .xml file to import.

3. Choose Open. The filter slides defined in the .xml file are imported into the 
filter slide list and replace all existing filter slides.
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2.3.3 Manually Controlling the Instrument
The Manual Control tab (Figure 2-5) provides options to control functions of the 
connected instrument, such as shaking microplates and ejecting or loading filter 
slides.

Manual Control is divided into five subsections:

• Temperature Control (880 only) (Section 2.3.3.1).

• Shake Control (Section 2.3.3.2).

• Plate Control (Section 2.3.3.3).

• Excitation and Emission Filter Slide Control (Section 2.3.3.4).

Figure 2-5.  Instrument Settings — Manual Control

2.3.3.1 Temperature Control (880 only)
Temperature Control is used to set the microplate chamber temperature. The 
temperature is set by heating the microplate chamber; cooling the chamber is not 
supported. Depending on the measurement wavelength and light source used in the 
protocol, the temperature may range from 3°C (5.4°F) or 4°C (7.2°F) above ambient 
to 45°C (113°F). Actual displays the current temperature inside the instrument.

To set the temperature:

1. In Set Point, enter the desired temperature in Celsius. 

2. Choose Set. Temperature control is activated for the instrument and begins to 
heat to the desired temperature. The set temperature is maintained until it is 
changed or the instrument is powered off.

Note:  It takes a minimum of 30 minutes for the instrument to reach the desired 
temperature. The actual time required depends on the relative change in 
temperature.

To turn off temperature control:

In Set Point, enter 0.

OR

Turn power to the instrument off and on.
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2.3.3.2 Shake Control
Shake Control is used to manually shake a 96- or 384-well microplate in the plate 
carrier.

To manually perform a shaking operation:

CAUTION: Shake low density plates, such as 6- or 48-well plates, at low 
speed only. Shaking low density plates at higher speeds may cause 
liquid in wells to spill.
1. In Mode, select the desired shaking mode:

• Linear — shakes from side to side.

• Orbital — shakes in a circular pattern.

• Squared — shakes in a square pattern, moving at right angles.

2. In Intensity, select the desired shaking intensity: Low, Medium, or High.

3. In Duration, enter the length of time to shake in seconds.

4. Choose Shake. The instrument shakes the microplate according to the 
configured settings.

2.3.3.3 Plate Control
Plate Control provides options to eject or load the plate carrier. It also features an 
option to sense that a microplate is in the plate carrier before starting a measurement.

To manually control the plate carrier:

• Choose Eject to extend the plate carrier outside the instrument.

• Choose Load to retract the plate carrier inside the instrument.

• Select Check if plate is inserted before each read to sense if a 
microplate is in the plate carrier before starting each measurement.

2.3.3.4 Excitation and Emission Filter Slide Control
Excitation Filter Slide Control and Emission Filter Slide Control are used to 
manually eject or load the excitation or emission filter slides.

To manually eject or load the excitation or emission filter slide:

• Choose Eject from the desired filter slide control section to unload the filter 
slide from the filter compartment and partially open the compartment door.

Note: To remove the filter slide, it is still necessary to grasp it by the tab 
and pull it until it is free of the geared track. Store the removed filter slide in 
a protected, dust-free area, preferably in the original packaging.

• Choose Load from the desired filter slide control section to retract the filter 
slide into position.
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3 Creating and Editing Detection 
Methods

3.1 Overview
Multimode Detection Software stores measurement configuration parameters in 
detection methods. Stored parameters include the method technique (for example, 
absorbance), filter(s) used, and parameters specific to the selected method, such as 
integration time. Absorbance, luminescence, and fluorescence method techniques are 
all supported. The method techniques available to the user depend on the capabilities 
of the instrument being controlled.

Detection methods are created and edited using the Method Editor and stored in the 
Detection Method Selection List. Once a detection method has been defined, it 
may be used in a measurement protocol (refer to Chapter 5, Defining, Editing, and 
Running Protocols).
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To view available detection methods and access the Method Editor:

From the navigation pane, choose Detection Methods. The Detection 
Method Selection List appears (Figure 3-1).

Figure 3-1.  Accessing detection method functions

All detection method functions are accessed from the Detection Method Selection 
List. Available detection method functions are:

• Creating Detection Methods (Section 3.2).

• Editing Detection Methods (Section 3.3).

• Copying Detection Methods (Section 3.4).

• Deleting Detection Methods (Section 3.5).

• Exporting and Importing Detection Methods (Section 3.6).

Detection method 
functions

Detection 
methods
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3.2 Creating Detection Methods
Detection methods are created in the Method Editor, which guides the creation 
process with a wizard-type interface. Creating a new detection method requires:

• Selecting a Method Technique (Section 3.2.1).

• Defining Method Parameters (Section 3.2.3).

Note:  When creating absorbance measurements, a third screen, Method Type, must 
also be configured (refer to Section 3.2.2, Selecting the Type of Absorbance Method).

To create and define a new detection method:

From the toolbar, choose Create a new method.

OR

From the Actions menu, choose Create a new method.

OR

Right-click in the Detection Method Selection List and choose Create a new 
method from the menu. The Method Editor appears (Figure 3-2). 

3.2.1 Selecting a Method Technique
In the Method Editor, the type of detection method to create is selected in Method 
Technique (Figure 3-2). Only techniques supported by the instrument currently 
selected in the Instrument Selection List are available for configuration (refer to 
Chapter 2, Setting Up and Controlling Instruments).

Figure 3-2.  Selecting a Method Technique
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To select a method technique:

1. In Supported techniques, choose the desired detection method.

2. If defining an absorbance method, choose Next to select the Method Type (refer 
to Section 3.2.2, Selecting the Type of Absorbance Method).

OR

If defining a luminescence or fluorescence method, choose Next to define 
Method Parameters (refer to Section 3.2.3, Defining Method Parameters). 

OR

Choose Cancel to close the Method Editor without defining a new detection 
method.

3.2.2 Selecting the Type of Absorbance Method
When defining an absorbance detection method, use Method Type to select 
whether a monochromatic or bichromatic method will be defined (Figure 3-3). 
Monochromatic methods perform a single-wavelength measurement. Bichromatic 
methods perform a second measurement at a reference wavelength, which is 
subtracted from the first to calculate the final result.

Note:  Method Type appears only when defining absorbance methods.

Figure 3-3.  Selecting an absorbance Method Type
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To select a method type:

1. In Method Type, choose the desired method: Monochromatic or 
Bichromatic.

2. Choose Next to define Method Parameters (refer to Section 3.2.3, Defining 
Method Parameters). 

OR

Choose Back to select a different Method Technique (refer to Section 3.2.1, 
Selecting a Method Technique).

OR

Choose Cancel to close the Method Editor without defining a new detection 
method.

3.2.3 Defining Method Parameters
Parameters, such as filters and integration time, are defined in Method Parameters. 
The parameters available for configuration depend on the technique selected in 
Method Technique (refer to Section 3.2.1, Selecting a Method Technique).

Use Method Parameters for:

• Defining Absorbance Method Parameters (Section 3.2.3.1).

• Defining Luminescence Method Parameters (Section 3.2.3.2).

• Defining Fluorescence Intensity Top Method Parameters (Section 3.2.3.3).

• Defining Fluorescence Intensity Bottom Method Parameters (880 only) 
(Section 3.2.3.4).

• Defining Fluorescence Polarization Method Parameters (880 only) (Section 
3.2.3.5).

• Defining Time-Resolved Fluorescence Method Parameters (880 only) 
(Section 3.2.3.6).
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3.2.3.1 Defining Absorbance Method Parameters
A monochromatic absorbance method performs an absorbance measurement at a 
single wavelength. A bichromatic method performs a second measurement at a 
reference wavelength. This measurement is subtracted from the first to calculate the 
final result.

Figure 3-4.  Defining absorbance measurement parameters

To define absorbance method parameters:

1. Enter a Method Name (Figure 3-4).

2. In Excitation Filter (nm), select the measurement filter.

3. If a bichromatic measurement is being defined, in Reference Excitation Filter 
(nm), select the reference filter. 

Note:  The filters available are those installed on the excitation filter slide loaded 
in the instrument and configured for absorbance techniques in Instrument 
Settings (refer to Section 2.3.2, Defining and Editing Filter Slides).

4. Choose Save to save the new absorbance detection method. The new method 
appears in the Detection Method Selection List.

OR

Choose Back to define a different Method Type (refer to Section 3.2.2, 
Selecting the Type of Absorbance Method).

OR

Choose Cancel to close the Method Editor without saving the new detection 
method.

Reference Excitation Filter
Appears only when configuring 
bichromatic measurements.
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3.2.3.2 Defining Luminescence Method Parameters
A luminescence method performs glow luminescence measurements on samples. 
Generally, luminescence measurements do not require a filter; however, cutoff 
filtration using an emission filter may be specified when eliminating 
photoluminescence generated by the microplate itself is desired.

Figure 3-5.  Defining luminescence measurement parameters

To define luminescence method parameters:

1. Enter a Method Name (Figure 3-5).

2. In Emission Filter (nm), select the cutoff filter.

Note:  Most luminescence measurements do not require cutoff filtration.

The filters available are those installed on the emission filter slide loaded in the 
instrument and configured for luminescence techniques in Instrument Settings 
(refer to Section 2.3.2, Defining and Editing Filter Slides).

3. In Integration Time (seconds), enter the length of time, in seconds, the signal is 
collected from samples. The integration time may be set within the range of 
0.00005 to 3600 seconds.

4. Choose Save to save the new luminescence detection method. The new method 
appears in Detection Method Selection List.

OR

Choose Back to select a different Method Technique (refer to Section 3.2.1, 
Selecting a Method Technique).

OR

Choose Cancel to close the Method Editor without saving the new detection 
method.
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3.2.3.3 Defining Fluorescence Intensity Top Method 
Parameters

In a fluorescence intensity top method, a light source above the plate is directed 
through an excitation filter, which passes only the wavelength necessary to excite 
samples. The resulting fluorescence passes through an emission filter that separates 
background light from the specific wavelength generated by samples. This signal is 
read from above the plate by the photo multiplier tube.

Figure 3-6.  Defining fluorescence intensity top method parameters

To define fluorescence intensity top method parameters:

1. Enter a Method Name (Figure 3-6).

2. Select the Excitation Filter (nm).

3. Select the Emission Filter (nm).

Note:  The filters available are those installed on the slides loaded in the 
instrument and configured for fluorescence techniques in Instrument Settings 
(refer to Section 2.3.2, Defining and Editing Filter Slides).

4. In Integration Time (seconds), enter the length of time, in seconds, the signal is 
collected from samples. The integration time may be set within the range of 
0.00005 to 3600 seconds.

5. Choose Save to save the new fluorescence intensity top detection method. The 
new method appears in the Detection Method Selection List.

OR

Choose Back to select a different Method Technique (refer to Section 3.2.1, 
Selecting a Method Technique).

OR

Choose Cancel to close the Method Editor without saving the new detection 
method.
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3.2.3.4 Defining Fluorescence Intensity Bottom Method 
Parameters (880 only)

In a fluorescence intensity bottom method, a light source below the plate is directed 
through an excitation filter, which passes only the wavelength necessary to excite 
samples. The resulting fluorescence passes through an emission filter that separates 
background light from the specific wavelength generated by samples. This signal is 
read from below the plate by the photo multiplier tube.

Figure 3-7.  Defining fluorescence intensity bottom method parameters

To define fluorescence intensity bottom method parameters:

1. Enter a Method Name (Figure 3-7).

2. Select the Excitation Filter (nm).

3. Select the Emission Filter (nm).

Note:  The filters available are those installed on the slides loaded in the 
instrument and configured for fluorescence techniques in Instrument Settings 
(refer to Section 2.3.2, Defining and Editing Filter Slides).

4. In Integration Time (seconds), enter the length of time, in seconds, the signal is 
collected from samples. The integration time may be set within the range of 
0.00005 to 3600 seconds.

5. Choose Save to save the new fluorescence intensity bottom detection method. 
The new method appears in the Detection Method Selection List.

OR

Choose Back to select a different Method Technique (refer to Section 3.2.1, 
Selecting a Method Technique).

OR

Choose Cancel to close the Method Editor without saving the new detection 
method.
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3.2.3.5 Defining Fluorescence Polarization Method 
Parameters (880 only)

A fluorescence polarization method performs a fluorescence intensity measurement 
where two orthogonal (perpendicular) polarization states are measured. 

A light source above the plate passes through an excitation filter, which passes only 
the wavelength necessary for excitation, and a polarizing filter. The fluorescence 
resulting from the excitation of the sample is separated by polarization and passed 
through two emission filters equipped with polarizing filters to ensure both 
polarization states are measured.

The polarized signal is then read from above the plate by the photo multiplier tube.

Figure 3-8.  Defining fluorescence polarization method parameters

To define fluorescence polarization parameters:

1. Enter a Method Name (Figure 3-8).

2. Select the Excitation Filter (nm).

3. Select the Emission Filter (nm).

Note:  The filters available are those installed on the excitation and emission 
filter slides loaded in the instrument and configured for fluorescence polarization 
techniques in Instrument Settings (refer to Section 2.3.2, Defining and Editing 
Filter Slides).

4. In Integration Time (seconds), enter the length of time, in seconds, the signal is 
collected from samples. The integration time may be set within the range of 
0.00005 to 3600 seconds.
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5. Choose Save to save the new fluorescence polarization detection method. The 
new method appears in the Detection Method Selection List.

OR

Choose Back to select a different Method Technique (refer to Section 3.2.1, 
Selecting a Method Technique).

OR

Choose Cancel to close the Method Editor without saving the new detection 
method.

3.2.3.6 Defining Time-Resolved Fluorescence Method 
Parameters (880 only)

In a time-resolved fluorescence measurement, the excitation light source is turned off 
and the measurement is performed after a specified delay. Several of these excitation/
measurement cycles may be performed on each sample. When multiple excitation/
measurement cycles are performed, the results from all cycles are used to calculate a 
single measurement result for each sample.

Figure 3-9.  Defining time-resolved fluorescence method parameters
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To define time-resolved fluorescence parameters:

1. Enter a Method Name (Figure 3-9).

2. Select the Excitation Filter (nm).

3. Select the Emission Filter (nm).

Note:  The filters available are those installed on the excitation and emission 
filter slides loaded in the instrument and configured for time-resolved 
fluorescence techniques in Instrument Settings (refer to Section 2.3.2, Defining 
and Editing Filter Slides).

4. In LED on Time (seconds), enter the length of time, in seconds, that the LED 
light source remains turned on.

5. In Number of Pulses, enter the number of excitation/measurement cycles 
performed in the measurement.

6. In Delay Before Measure (seconds), enter the interval, in seconds, between 
switching off the light source and performing the measurement. The delay may 
be set within the range of 0.000001 to 0.0075 of a second.

7. In Integration Time (seconds), enter the length of time, in seconds, each 
sample is measured. The integration time may be set within the range of 0.00005 
to 0.0075 of a second.

8. Choose Save to save the new time-resolved fluorescence detection method. The 
new method appears in the Detection Method Selection List.

OR

Choose Back to select a different Method Technique (refer to Section 3.2.1, 
Selecting a Method Technique).

OR

Choose Cancel to close the Method Editor without saving the new detection 
method.
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3.3 Editing Detection Methods
Parameters configured in saved detection methods may be edited; however, the 
method technique may not be changed. Default detection methods provided with the 
software and methods used in protocols may not be renamed.

To edit a detection method:

1. In the Detection Method Selection List, select the detection method to edit.

2. From the toolbar, choose Edit the selected method.

OR

From the Actions menu, choose Edit the selected method.

OR

Right-click on the selected detection method and choose Edit the selected 
method from the menu. The Method Editor appears (Figure 3-10).

Figure 3-10.  Editing a fluorescence intensity top method
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3. Edit the method parameters as desired. For more information about the 
parameters for a specific detection method, refer to the section that covers 
defining the desired detection method:

• Defining Absorbance Method Parameters (Section 3.2.3.1).

• Defining Luminescence Method Parameters (Section 3.2.3.2).

• Defining Fluorescence Intensity Top Method Parameters (Section 
3.2.3.3).

• Defining Fluorescence Intensity Bottom Method Parameters (880 only) 
(Section 3.2.3.4).

• Defining Fluorescence Polarization Method Parameters (880 only) 
(Section 3.2.3.5).

• Defining Time-Resolved Fluorescence Method Parameters (880 only) 
(Section 3.2.3.6).

4. Choose Save to close the Method Editor and save the changes.

OR

Choose Cancel to close the Method Editor without saving changes.
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3.4 Copying Detection Methods
Copies may be made of existing detection methods. After a copy has been created, it 
may be used as a template for a new detection method using the same method 
technique.

To make a copy of a detection method:

1. In the Detection Method Selection List, select the detection method to copy.

2. From the toolbar, choose Make a copy of the selected method.

OR

From the Actions menu, choose Make a copy of the selected method.

OR

Right-click on the selected detection method and choose Make a copy of the 
selected method from the menu that appears. 

Note:  The default name format for copied detection methods is Copy of 
OriginalName. To change the name, edit the detection method (refer to Section 
3.3, Editing Detection Methods).
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3.5 Deleting Detection Methods
User-created detection methods not used in any measurement protocols may be 
deleted from the Detection Method Selection List. Default detection methods 
provided with the software and user-created methods used in protocols may not be 
deleted.

To delete a detection method:

1. In the Detection Method Selection List, select the detection method to delete.

2. From the toolbar, choose Delete the selected method.

OR

From the Actions menu, choose Delete the selected method.

OR

Right-click on the selected detection method and choose Delete the selected 
method from the menu. Message appears (Figure 3-11).

Figure 3-11.  Confirming the deletion of a detection method

3. Choose Yes to delete the selected detection method.

OR

Choose No to cancel the deletion.



Creating and Editing Detection Methods 3-17

Multimode Detection Software User’s Manual

3.6 Exporting and Importing Detection Methods
User-defined detection methods saved in the Detection Method Selection List can 
be exported to an XML file and imported later to restore that configuration or share it 
with a copy of Multimode Detection Software installed on another computer. 

Exporting default detection methods included with the software installation is not 
necessary. Since a default detection method may not be edited, deleted, or 
overwritten, it is available to users at all times. Because of this, importing a default 
detection method from an XML export file is not permitted by the software.

To export a detection method:

1. In the Detection Method Selection List, select the detection method to export. 

2. From the File menu, choose Export>Detection Method. Browse for Folder 
appears (Figure 3-12).

Figure 3-12.  Choosing the folder where an exported detection method will be saved

3. In Browse for Folder, browse to the folder where the exported detection method 
will be saved.

OR

Choose Make New Folder to create a new folder where the exported detection 
method will be saved.

4. Choose OK to export the detection method. The exported detection method is 
saved using the default file name format, Method__MethodName.xml. In order 
to import the file at a later date, the filename must not be changed. 

OR

Choose Cancel to stop the operation without exporting the detection method.
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To import a detection method from an exported XML file:

1. From the File menu, choose Import>Detection Method. Open appears.

2. In Open, browse to and select the desired XML file to import.

3. Choose Open. The detection method is imported to the Detection Method 
Selection List.
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4 Creating and Editing Labware

4.1 Overview
Multimode Detection Software supports a wide range of labware, with many common 
microplate formats already preconfigured and ready for use in protocols. Configured 
labware types are listed in the Labware Selection List and are available for use in 
protocols.

New labware types may be created at any time using the Labware Editor. The 
Labware Editor also provides the ability to edit and delete existing labware types not 
used in protocols, make copies of labware types, and optimize labware dimensions to 
compensate for slight dimensional variations that may exist between production lots.

DTX 800 — supports 96-well and 384-well microplates.

DTX 880 — supports 6- to 384-well microplates.

All labware functions are accessed from the Labware Selection List (Figure 4-1). 
Labware functions include:

• Creating Labware (Section 4.2).

• Editing Labware (Section 4.3).

• Copying Labware (Section 4.4).

• Deleting Labware (Section 4.5).

• Optimizing Labware (Section 4.6).

• Exporting and Importing Labware (Section 4.7).
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To define and edit labware:

From the navigation pane, choose Labware. The Labware Selection List 
appears (Figure 4-1).

Figure 4-1.  Accessing labware functions

Labware 
functions

Labware
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4.2 Creating Labware
New types of labware are created in the Labware Editor, which guides the creation 
process with a wizard-type interface. Creating labware includes:

• Defining Labware Information (Section 4.2.1).

• Configuring Offsets and Well Dimensions for the Default Labware Lot 
(Section 4.2.2).

To create and define new labware:

From the toolbar, choose Create a new piece of labware. The Labware 
Editor appears (Figure 4-2).

OR

From the Actions menu, choose Create a new piece of labware.

OR

Right-click in the Labware Selection List and choose Create a new piece of 
labware from the menu.

4.2.1 Defining Labware Information
Use Labware Information to define labware names, dimensions, well parameters, 
and supported measurement techniques (Figure 4-2).

Figure 4-2.  Defining plate dimensions and information

Property 
grid

Information about the 
field being configured.
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To define Labware Information:

1. If necessary, click the + next to Labware Info to display the fields in the 
category.

2. Enter the Plate Name. A name must be entered to proceed to the second 
configuration screen, Labware Lots.

3. If necessary, click the + next to Labware Measurements to display the fields in 
the category.

Note:  More information about the field being defined is displayed below the 
property grid (Figure 4-2).

CAUTION: The plate height configured must not be less than that of the 
actual plate. Doing so may cause the DTX 880 optics transport to collide 
with the plate during a Read Height Optimization.
4. Enter the Height of the plate. All labware dimensions are entered in centimeters.

5. Enter the Height with lid. 

6. Enter the Length of the plate.

7. In Reading height, enter the height from the top of the plate at which the plate is 
read.

8. Enter the Width of the plate.

9. If necessary, click the + next to Well Info to display the fields in the category.

10. Enter the number of Columns on the plate.

11. Enter the number of Rows on the plate.

12. Click in either column of Well bottom shape, then click on the down arrow and 
choose the shape of well bottoms: Flat, Cone, or Round.

13. Click in either column of Well shape, then click on the down arrow and choose 
the shape of the wells: Round, Square, or Cone.

14. Enter the maximum Well volume in microliters.

15. In Supported Techniques, select all measurement techniques compatible with 
the plate being defined. Labware may be used only in protocols that use a 
compatible measurement technique.

Note:  Refer to Section 4.2.1.1, General Labware Selection Guidelines for more 
information about choosing the appropriate labware for the desired techniques.

16. In Notes, enter information about the labware or configuration, if desired.

17. Choose Next to define the default row and column offsets and well dimensions 
for the labware type in Labware Lots (refer to Section 4.2.2, Configuring 
Offsets and Well Dimensions for the Default Labware Lot).

OR

Choose Cancel to close the Labware Editor without creating or saving new 
labware.
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4.2.1.1 General Labware Selection Guidelines
When creating labware, select only measurement techniques compatible with the 
microplate being defined. Each measurement technique requires labware of a specific 
color and/or material be used. 

Table 4-1 provides general labware color and material guidelines for each 
measurement technique. Along with these basic guidelines, always select microplates 
with a surface treatment suitable for the desired application, and follow any additional 
guidelines provided by the plate manufacturer.

4.2.2 Configuring Offsets and Well Dimensions 
for the Default Labware Lot

Use Labware Lots to define row and column offsets and well dimensions (Figure 4-
3). The offsets and dimensions entered when new labware is created define the default 
labware lot (DefaultLot). After the new labware has been saved, additional lots may 
be created by optimizing the labware to compensate for dimensional variations 
between different production lots (refer to Section 4.6, Optimizing Labware).

In Labware Lots, x and y offsets are defined for all four corners of the labware. An x 
offset is the distance from the edge of the microplate to the first row; a y offset is the 
distance from the edge of plate to the first column. Well dimensions defined include 
well depth, length, and width, as well as distances between rows and columns.

To configure offsets and well dimensions:

1. If necessary, click the + next to Labware Lot Measurements to display the 
fields in the category. More information about the field being defined is 
displayed below the property grid (Figure 4-3).

Note:  The fields in Labware Lot Info may not be configured when creating 
new labware.

Table 4-1.  General Microplate selection guidelines
Measurement 

Technique
Supported 
Plate Color

Additional 
Considerations

Absorbance clear, white with 
clear bottom, or 
black with clear 
bottom

Clear polystyrene or film plates with transparent 
bottoms are suitable. Polypropylene or PVC 
plates do not provide sufficient optical quality.

Luminescence Glow 
Type

solid black or solid 
white

Black plates are recommended unless the signal 
is weak enough to require the higher sensitivity 
of white plates. However, with strong signals, 
white plates may produce crosstalk.

Fluorescence Intensity 
Top

solid black N/A

Fluorescence Intensity 
Bottom

black with clear 
bottom

N/A

Fluorescence 
Polarization

solid black N/A

Time-Resolved 
Fluorescence

solid white N/A
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2. Enter column and row x and y offsets for each of the four corner wells. All offsets 
and well dimensions are entered in centimeters.

Figure 4-3.  Defining offsets and well dimensions

3. If necessary, click the + next to Well Measurements to display the fields in the 
category.

4. In Column Distance, enter the distance between columns.

5. In Row Distance, enter the distance between rows.

6. Enter the Well depth. 

7. In Well Length, enter the length of the well in the direction of the columns on the 
plate.

8. In Well Width, enter the length of the well in the direction of the rows on the 
plate.

9. In Notes, enter information about the labware lot or configuration, if desired.

10. Choose Save to save the new labware and close the Labware Editor.

OR

Choose Back to edit Plate Information (refer to Section 4.2.1, Defining 
Labware Information).

OR

Choose Cancel to close the Labware Editor without creating new labware.

Property 
grid

Information about the 
field being configured.



Creating and Editing Labware 4-7

Multimode Detection Software User’s Manual

4.3 Editing Labware
Dimensions and information for user-defined labware not used in measurement 
protocols may be edited. For default labware included in the software installation or 
labware used in protocols, dimensions and information may be viewed, but not 
edited. 

When labware lots have been created by optimizing the labware to compensate for 
dimensional variations between production lots, the active lot may be changed and/or 
edited. The active lot may be selected and/or edited for all labware in the Labware 
Selection List.

Note:  Labware lots are created by optimizing the labware (refer to Section 4.6, 
Optimizing Labware).

Labware is edited in the Labware Editor (Figure 4-4) and includes:

• Viewing and Editing Labware Information (Section 4.3.1).

• Selecting and Editing Labware Lots (Section 4.3.2).

To view and edit labware dimensions and information:

1. In the Labware Selection List, select the labware to edit.

2. From the toolbar, choose Edit the selected labware.

OR

From the Actions menu, choose Edit the selected labware.

OR

Right-click on the selected labware and choose Edit the selected labware 
from the menu that appears.
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4.3.1 Viewing and Editing Labware Information
Use Labware Information to view and edit labware dimensions, information, and 
supported techniques. Plate information for default labware included in the software 
installation and labware used in protocols may be viewed, but not edited.

Figure 4-4.  Editing labware dimensions and well information

To edit labware information:

1. In the property grid, edit labware dimensions and information as desired. Refer to 
Section 4.2.1, Defining Labware Information, for more information about the 
fields available in the property grid.

2. In Supported Techniques, change the measurement techniques supported by 
the labware, if desired.

Note:  Refer to Section 4.2.1.1, General Labware Selection Guidelines for more 
information about labware/technique compatibility.

3. Edit the labware Notes, if desired.

4. Choose Next to select and edit labware lots and save changes made to the 
labware (refer to Section 4.3.2, Selecting and Editing Labware Lots).

OR

Choose Cancel to close the Labware Editor without saving changes.

Property 
grid
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4.3.2 Selecting and Editing Labware Lots
Use Labware Lots to select the active lot and/or edit and save changes made in the 
Labware Editor (Figure 4-5). Lots can be selected and edited for all labware, 
including labware used in measurement protocols.

Note:  Labware Lots are created by optimizing labware (refer to Section 4.6, 
Optimizing Labware).

Figure 4-5.  Configuring offsets and well dimensions in Labware Lots

To select and edit lots:

1. From the pull-down menu, choose the lot to use or edit. The default lot created 
when the labware was defined and all lots configured using Optimizing 
Labware are available (refer to Section 4.6, Optimizing Labware).

2. Click in Current labware lot and choose True, if necessary. True must be 
selected in order to save changes made to the labware lot.

3. In the property grid, edit lot dimensions and information as desired. Refer to 
Section 4.2.2, Configuring Offsets and Well Dimensions for the Default Labware 
Lot, for more information about the fields available in the property grid.

4. Edit the lot Notes, if desired.

5. Choose Save to save changes made in the Labware Editor.

OR

Choose Back to view or edit Plate Information (refer to Section 4.3.1, Viewing 
and Editing Labware Information).

OR

Choose Cancel to close the Labware Editor without saving changes.

Choose the lot 
to use or edit.

Property 
grid
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4.4 Copying Labware
Labware can be copied and then used as a template for a new labware type by editing 
the dimensions and parameters in the Labware Editor (refer to Section 4.3, Editing 
Labware).

To make a copy of a labware type:

1. In the Labware Selection List, select the labware type to copy.

2. From the toolbar, choose Make a copy of the selected labware.

OR

From the Actions menu, choose Make a copy of the selected labware.

OR

Right-click on the selected labware type and choose Make a copy of the 
selected labware from the menu that appears.

Note:  The default name format for copied labware types is Copy of 
OriginalName. To change the name, edit the labware type (refer to Section 4.3, 
Editing Labware).
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4.5 Deleting Labware
User-defined labware not used in any measurement protocols may be deleted from the 
Labware Selection List. Default labware included with the software installation and 
labware used in protocols may not be deleted.

To delete labware:

1. In the Labware Selection List, select the labware to delete.

2. From the toolbar, choose Delete the selected labware.

OR

From the Actions menu, choose Delete the selected labware.

OR

Right-click on the selected labware and choose Delete the selected labware 
from the menu that appears. Message appears (Figure 4-6).

Figure 4-6.  Confirming a labware deletion

3. Choose Yes to delete the selected labware.

OR

Choose No to cancel the deletion.
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4.6 Optimizing Labware
Microplate dimensions may vary slightly between production lots, which potentially 
affects measurement accuracy. Multimode Detection Software provides the ability to 
create different labware lots for each type of labware, which increases accuracy by 
optimizing labware dimensions and information for each production lot used. 

Labware is optimized in Optimizing Labware (Figure 4-7), which guides the process 
with a wizard type interface. Optimizing labware includes:

• Selecting the Detection Method (Section 4.6.1).

• Preparing and Loading the Labware (Section 4.6.2).

• Performing the Optimization Read (Section 4.6.3).

• Selecting the Centers of the Four Corner Wells (Section 4.6.4).

• Verifying Well Centers (Section 4.6.5).

To optimize labware:

1. In the Labware Selection List, select the labware to optimize.

2. From the toolbar, choose Optimize the selected labware.

OR

From the Actions menu, choose Optimize the selected labware.

OR

Right-click on the selected labware and choose Optimize the selected 
labware from the menu that appears.
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4.6.1 Selecting the Detection Method
Labware is optimized by performing absorbance measurements of the four corner 
wells of the microplate and then defining the well centers using images of the wells 
generated by the measurements. To ensure the most accurate optimization is 
performed, use Select Detection Method to select the most appropriate detection 
method for the optimization (Figure 4-7).

Figure 4-7.  Selecting the detection method for labware optimization

To select the detection method:

1. Choose the detection method that most closely matches the method used in the 
desired protocol. For absorbance and fluorescence intensity top and bottom 
measurements, this is the exact method used. For luminescence, fluorescence 
polarization, and time-resolved fluorescence measurements, choose a method 
performed at the same or similar wavelength.

2. Choose Next to Prepare Labware (refer to Section 4.6.2, Preparing and 
Loading the Labware).

OR

Choose Cancel to close Optimizing Labware without performing the 
optimization.
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4.6.2 Preparing and Loading the Labware
To optimize labware dimensions, the four corner wells of the plate are read while 
empty. Prepare Labware provides controls to load and eject labware from the 
instrument and to choose the orientation of the plate on the microplate carrier 
(Figure 4-8).

Figure 4-8.  Preparing the labware for optimization

To prepare labware for optimization:

1. Choose Eject Plate Carrier to move the microplate carrier outside the 
instrument.

2. Place the microplate to be optimized on the plate carrier.

3. Choose Close Plate Carrier to load the microplate into the instrument.

4. In Select Plate Orientation, choose the orientation of the plate on the 
microplate carrier. The selected orientation is displayed graphically to the right of 
the screen, with well A1 highlighted in red.

5. Choose Next to start the optimization (refer to Section 4.6.3, Performing the 
Optimization Read). The optimization read begins automatically.

OR

Choose Back to select a different detection method (refer to Section 4.6.1, 
Selecting the Detection Method).

OR

Choose Cancel to close Optimizing Labware without performing the 
optimization.

Plate orientation
Well A1 is highlighted 
in red.
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4.6.3 Performing the Optimization Read
Optimization in Progress displays the status of the optimization read and provides 
the ability to cancel the optimization in progress (Figure 4-9). The optimization read 
requires several minutes to complete.

Figure 4-9.  Labware optimization in progress

During the optimization read:

Choose Stop Optimization to cancel the optimization process and close 
Optimizing Labware without saving the optimization data.

When the optimization read is complete:

Choose Next to select the centers of the four corner wells (refer to Section 4.6.4, 
Selecting the Centers of the Four Corner Wells).

OR

Choose Cancel to close Optimizing Labware without performing the 
optimization.
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4.6.4 Selecting the Centers of the Four Corner 
Wells

Use Select Center to precisely define the centers of the corner wells read in the 
optimization (Figure 4-10). Select Center displays an image of the well generated 
by the absorbance measurement. Well centers are defined graphically by dragging 
cross hairs to the position visually identified as the center. Select Center is 
performed for each corner well individually.

Figure 4-10.  Selecting the well center

To define the centers of the wells:

1. Place the cursor in the well image, then click and drag the cross hairs to the 
desired center of the well.

2. Choose Next to define the center of the next well read. When all four well 
centers are defined, Verify Well Centers appears (refer to Section 4.6.5, 
Verifying Well Centers).

OR

Choose Cancel to close Optimizing Labware without completing the 
optimization.
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4.6.5 Verifying Well Centers
Use Verify Well Centers to verify that the x and y offsets and distances between 
rows and columns are correct (Figure 4-11). If desired, the offsets, distances, and lot 
name may be edited in Verify Well Centers.

Figure 4-11.  Verifying well centers

To verify and edit offsets, distances, and lot name:

1. If necessary, click the + next to Labware Lot Dimensions to display the fields 
in the category.

Note:  More information about the field being defined is displayed below the 
property grid (Figure 4-11).

2. In Column distance, verify the distance between columns and edit the 
dimension. All offsets and well dimensions are entered in centimeters, if desired.

3. Verify the x and y offsets for the lower two wells and edit the dimensions, if 
desired.

4. In Row distance, verify the distance between rows and edit the dimension, if 
desired.

5. Verify the x and y offsets for the upper two wells and edit the dimensions, if 
desired.

6. If necessary, click the + next to Labware Lot Name to display the default name 
assigned to the new labware lot.

7. Enter a new Lot ID/Name, if desired.

Property 
grid

Information about the 
field being configured.
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8. Choose Save to save the optimization data and create the new labware lot. 

Note:  To use the optimized lot in a measurement protocol, open the labware for 
editing and select the new Labware Lot (refer to Section 4.3.2, Selecting and 
Editing Labware Lots).

OR

Choose Back to redefine well centers graphically (refer to Section 4.6.4, 
Selecting the Centers of the Four Corner Wells).

OR

Choose Cancel to close Optimizing Labware without completing the 
optimization.
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4.7 Exporting and Importing Labware
User-defined labware saved in the Labware Selection List can be exported to an 
XML file and imported later to restore that configuration or share it with a copy of 
Multimode Detection Software installed on another computer. 

Exporting default labware included with the software installation is not necessary. 
Since default labware may not be edited, deleted, or overwritten, it is available to 
users at all times. Because of this, importing default labware from an XML export file 
is not permitted by the software.

To export labware:

1. In the Labware Selection List, select the labware to export. 

2. From the File menu, choose Export>Labware. Browse for Folder appears 
(Figure 4-12).

Figure 4-12.  Choosing the folder where exported labware will be saved

3. In Browse for Folder, browse to the folder where the exported labware will be 
saved.

OR

Choose Make New Folder to create a new folder where the exported labware 
will be saved.

4. Choose OK to export the labware. The exported labware is saved using the 
default file name format, Labware__LabwareName.xml. In order to import the 
file at a later date, the filename must not be changed. 

OR

Choose Cancel to stop the operation without exporting labware.
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To import labware from an exported XML file:

1. From the File menu, choose Import>Labware. Open appears.

2. In Open, browse to and select the desired XML file to import.

3. Choose Open. The labware is imported to the Labware Selection List.
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5 Defining, Editing, and Running 
Protocols

5.1 Overview
A protocol stores all parameters required to perform a measurement, including 
technique type, labware type, detection method(s), and preparation methods, such as 
shaking. Protocols are stored in the Protocol Selection List (Figure 5-1), which 
provides access to all protocol functions:

• Creating Protocols (Section 5.2).

• Running Protocols (Section 5.3).

• Editing Protocols (Section 5.4).

• Copying Protocols (Section 5.5).

• Deleting Protocols (Section 5.6).

• Printing Protocol Configuration Information (Section 5.7).

• Exporting and Importing Protocols (Section 5.8).
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To select protocols and access protocol functions:

From the navigation pane, choose Protocols. The Protocol Selection List 
appears (Figure 5-1).

Figure 5-1.  Protocol Selection List

Protocol 
functions

Protocols
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5.2 Creating Protocols
New protocols are defined in Create Protocol, which guides the creation process 
with a wizard-type interface. Creating a new protocol requires:

• Configuring General Settings (Section 5.2.1).

• Selecting the Technique Type (Section 5.2.2).

• Selecting the Labware Type Used in the Protocol (Section 5.2.3).

• Configuring Labware Layout Settings (Section 5.2.4).

• Configuring Detection and Preparation Methods (Section 5.2.5).

• Configuring Output Settings (Section 5.2.6).

To create and configure a new protocol:

From the toolbar, choose Create a new protocol.

OR

From the Actions menu, choose Create a new protocol.

OR

Right-click in the Protocol Selection List and choose Create a new protocol 
from the menu. Create Protocol appears (Figure 5-2). 

5.2.1 Configuring General Settings
Use General Settings to define the protocol name and enter any related notes about 
the protocol (Figure 5-2).

Figure 5-2.  Defining a protocol name and entering notes about the protocol
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To configure the general settings for a new protocol:

1. In Protocol name, enter a unique name for the protocol. The name must be 
entered before the next configuration screen in the wizard can be accessed.

2. In Notes, enter a description of the new protocol, if desired.

3. Choose Next to select the measurement technique used in the protocol (refer to 
Section 5.2.2, Selecting the Technique Type).

OR

Choose Cancel to close Create Protocol without saving the new protocol.

5.2.2 Selecting the Technique Type
Use Technique Type to select the measurement technique performed by the protocol 
(Figure 5-3). Only techniques supported by the instrument and for which detection 
methods have already been defined are available. For more information about 
technique types, refer to Chapter 3, Creating and Editing Detection Methods.

Figure 5-3.  Selecting the measurement technique for a DTX 880
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To select a technique type:

1. In Technique Type, choose the desired technique.

2. Choose Next to select the type of labware used in the protocol (refer to Section 
5.2.3, Selecting the Labware Type Used in the Protocol). 

OR

Choose Back to configure General Settings for the protocol (refer to Section 
5.2.1, Configuring General Settings).

OR

Choose Cancel to close Create Protocol without saving the new protocol.

5.2.3 Selecting the Labware Type Used in the 
Protocol

Use Labware Selection to select the type of labware used in the protocol (Figure 
5-4). Labware must be configured prior to configuring the protocol. Only labware 
configured for the selected technique type is available. Labware cannot be edited once 
it is used in a protocol. Refer to Chapter 4, Creating and Editing Labware, for detailed 
information about creating and configuring labware.

Figure 5-4.  Selecting the type of labware used in the protocol
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To select labware:

1. Select the desired Type of Labware from the list.

2. Choose Next to configure the plate layout (refer to Section 5.2.4, Configuring 
Labware Layout Settings). 

OR

Choose Back to change the measurement technique performed by the protocol 
(refer to Section 5.2.2, Selecting the Technique Type).

OR

Choose Cancel to close Labware Selection without saving the new protocol.

5.2.4 Configuring Labware Layout Settings
Use Layout Settings to configure how wells on the plate are read (Figure 5-5). 
Settings are configured in two tabs:

• Layout Selection Settings — configures which wells are read in the 
measurement (Figure 5-5).

• Reading Direction Settings — configures the order of how wells are read: 
row-by-row, column-by-column, or well-by-well (Figure 5-6).

To configure labware layout settings:

1. In Layout Settings, choose the Layout Selection Settings tab to view the 
layout of the selected labware (Figure 5-5).

Figure 5-5.  Selecting which wells are measured on a 384-well plate

Select wells by dragging.

Click a row header 
to select all wells in 
that row.

Click a column header to select 
all wells in that column.Click this button 

to select all wells 
on the plate.

Selected 
wells
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2. Select the desired wells to read:

• All wells on the plate — click the small button in the upper left corner 
of the plate layout display.

• All wells in a column — click the desired column header. Multiple 
columns may be selected.

• All wells in a row — click the desired row header. Multiple rows may 
be selected.

• Individual wells — click each desired well.

• Groups of wells — click and drag over the desired group of wells. 
Multiple groups may be selected.

Note:  Wells are deselected using the methods listed above; for example, 
clicking the header of a selected column deselects all wells in the column.

3. Choose the Reading Direction Settings tab to configure the order in which 
wells are read in the protocol (Figure 5-6).

Figure 5-6.  Selecting how wells on the plate are read

4. Select the desired reading direction:

• Read by row — Reads plates row-by-row.

• Read by column — Reads plates column-by-column. Available for 
all measurement techniques except absorbance.

• Read by well — Reads each well individually before reading the next 
well, which is useful for kinetic and scan measurements.

Read by Column
Available for all measurement 
techniques except absorbance.
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5. Choose Next to configure detection and preparation methods (refer to Section 
5.2.5, Configuring Detection and Preparation Methods). 

OR

Choose Back to select a different labware type (refer to Section 5.2.3, Selecting 
the Labware Type Used in the Protocol).

OR

Choose Cancel to close Create Protocol without saving the new protocol.

5.2.5 Configuring Detection and Preparation 
Methods

Use Method Selection to select and configure detection and preparation methods 
(Figure 5-7). Two configuration modes are available:

• Basic — a single detection method may be selected and optionally 
configured as a kinetic or scan measurement, if desired. Microplate shaking 
may also be configured (refer to Section 5.2.5.1, Configuring a Method in 
Basic Mode).

• Advanced — provides the configuration options available in basic mode 
and adds the ability to define multiple detection methods and to configure 
preparation methods, such as shaking and temperature control (880 only). 
Detection and preparation methods may be arranged in any order within the 
execution sequence (refer to Section 5.2.5.2, Configuring a Method in 
Advanced Mode).

Figure 5-7.  Configuring parameters in Method Selection

Toggle between basic 
and advanced modes.
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5.2.5.1 Configuring a Method in Basic Mode
Configuring a method in basic mode includes selecting a detection method and 
configuring properties for a kinetic or scan measurement and shaking, if desired.

To select and configure a method in basic mode:

1. In Method Selection, choose Basic to toggle from advanced mode, if 
necessary. Basic mode configuration parameters appear (Figure 5-8). Refer to 
Section 5.2.5.2, Configuring a Method in Advanced Mode, to configure a method 
with multiple detection and/or preparation methods.

Figure 5-8.  Configuring a method in basic mode

2. In Method Selection, select the detection method for use with the protocol. 
Only detection methods of the technique selected for the protocol are available 
(refer to Section 5.2.2, Selecting the Technique Type).

OR

Choose New Method to create a new detection method using the currently-
selected technique type. Refer to Chapter 3, Creating and Editing Detection 
Methods, for more information about creating detection methods.

3. To configure a kinetic measurement, in Method Properties, click in Kinetic and 
choose Yes. Kinetic measurements read wells several times at specified 
intervals.

Note:  If a kinetic measurement not desired, proceed to step 6.

4. In Kinetic Cycles, enter the number of measurement cycles to be performed. 
Kinetic measurements may be set to perform 1 to 100 cycles.

Method 
Selection

Method 
Properties

Information about the property 
field being configured.
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5. In Kinetic Interval, enter the length of time, in seconds, between each 
measurement of the same well.

Note:  The minimum kinetic interval is populated automatically in Kinetic 
Interval, and is determined by the labware type and layout settings configured in 
the protocol. The maximum interval between each measurement cycle is 65,535 
seconds.

6. To shake the microplate before performing the measurement, click in Shake and 
choose Yes. In kinetic measurements, the plate is shaken for the specified 
intensity and interval before each measurement cycle.

Note:  If shaking is not desired, proceed to step 10.

CAUTION: Shake low density plates, such as 6- or 48-well plates, at low 
speed only. Shaking low density plates at higher speeds may cause 
liquid in wells to spill.
7. In Shake Intensity, select the desired intensity of shaking: Low, Medium, or 

High.

8. In Shake Interval, enter the length of time in seconds (0–60) to shake the 
microplate.

9. In Shake Mode, select the desired shaking pattern.

• Linear — shakes from side to side.

• Orbital — shakes labware in a circular pattern.

• Squared — shakes labware in a square pattern, moving at right angles.

10. To configure an area or linear scan, click in Scan and select Yes. Area scans 
read a number of measurement points arranged in a grid pattern across each well. 
Linear scans read a number of points in a linear axis crossing the center of each 
well. Scan measurements are not available when a kinetic measurement is 
configured.

Note:  Scans may only be performed on samples on plates with 96 or fewer 
wells.

Note:  If a scan measurement is not desired, proceed to step 15.



Defining, Editing, and Running Protocols 5-11

Multimode Detection Software User’s Manual

11. To configure the type of scan measurement and the number of points measured, 
click in Scan Points and choose the configuration button. Scan Selection 
Editor appears (Figure 5-9).

Figure 5-9.  Configuring an area scan

12. In Resolution (mm), use the up and down arrows to choose the proximity of 
measurement points. Choosing a smaller value increases the number of 
measurement points available; choosing a larger value decreases the number of 
points available. Available resolutions are determined by the type of labware 
selected and configured in the protocol. Refer to Sections 5.2.3, Selecting the 
Labware Type Used in the Protocol and 5.2.4, Configuring Labware Layout 
Settings, for more information. 

Resolution (mm)

Well 
boundary

Measurement points
Click and drag until the desired 
number of points is selected. 
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13. To configure an area scan, click anywhere inside the well boundary, except the 
center row, and drag until the desired number of measurement points is selected 
(Figure 5-9).

OR

To configure a linear scan, click anywhere on the center row or column inside the 
well boundary and drag towards the boundary until the desired number of 
measurement points is selected (Figure 5-10). 

Note:  The type of scan that may be configured is determined by the Reading 
Direction Settings in Layout Settings (refer to Section 5.2.4, Configuring 
Labware Layout Settings). For example, horizontal linear scans along the center 
row may be configured only when Read by row is selected, while vertical linear 
scans along the center column may be configured only when Read by column is 
selected. When Read by well is selected, only area scans may be configured.

Figure 5-10.  Configuring a linear scan

14. Choose OK to save the scan configuration and close the Scan Selection Editor.

OR

Choose Cancel to close the Scan Selection Editor without updating changes.

Measurement points
Click on the center row or column 
and drag until the desired number 
of points is selected. 

Well 
boundary



Defining, Editing, and Running Protocols 5-13

Multimode Detection Software User’s Manual

15. Choose Next to configure how measurement results are saved and/or printed 
(refer to Section 5.2.6, Configuring Output Settings). 

OR

Choose Back to configure the plate layout (refer to Section 5.2.4, Configuring 
Labware Layout Settings).

OR

Choose Cancel to close Create Protocol without saving the new protocol.

5.2.5.2 Configuring a Method in Advanced Mode
Configuring methods in advanced mode includes selecting detection and preparation 
methods, arranging the execution sequence of methods, and optionally configuring 
properties for a kinetic or scan measurement.

Protocols that require multiple measurements at different wavelengths, such as 
multiwavelength absorbance or fluorescence resonance energy transfer (FRET) 
measurements, must be configured in advanced mode.

To select and configure a method in advanced mode:

1. In Method Selection, choose Advanced to toggle from basic mode, if 
necessary. Advanced mode configuration parameters appear (Figure 5-11). Refer 
to Section 5.2.5.1, Configuring a Method in Basic Mode, to configure a protocol 
that requires only one detection method and no preparation methods.

Figure 5-11.  Configuring a method in advanced mode

Adds a 
method. 

Moves the selected method 
forward or backward in the 
execution sequence.

Method Selection
Add or remove methods and change 
the order in which they are executed.

Deletes the 
selected 
method.

Method Properties
Configure a kinetic or 
scan measurement.
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2. Add a detection method by choosing Add a method to this protocol, then 
selecting the desired Detection Method from the menu that appears.

OR

Right-click in Method Selection and choose Add Method>Detection 
Methods> and the desired detection method from the menu that appears.

OR

Choose New Method to create a new detection method. Refer to Chapter 3, 
Creating and Editing Detection Methods, for detailed information about creating 
detection methods.

3. Configure Method Properties as desired. Refer to Section 5.2.5.1, Configuring 
a Method in Basic Mode, for more information about configuring method 
property parameters.

4. Add and configure additional detection methods by repeating steps 2 and 3 for 
each method desired.

5. Add a preparation method by choosing Add a method to this protocol, then 
selecting Preparation Methods>Shake or Set Temperature from the menu 
that appears.

OR

Right-click in Method Selection and choose Add Method>Preparation 
Methods>Shake or Set Temperature from the menu that appears.

DTX 880 — Set Temperature is available only when controlling this 
instrument. 

6. Configure the preparation method as desired. Refer to Section 5.2.5.2.1, 
Configuring a Shake Preparation Method, for more information about shaking. 
Refer to Section 5.2.5.2.2, Configuring a Set Temperature Preparation Method 
(880 only), for more information about configuring temperature control in the 
protocol.

7. Add and configure additional preparation methods by repeating steps 5 and 6 for 
each method desired.

 
8. To reorder the detection and preparation methods in the method execution 

sequence, select the method to be moved and choose Move the selected 
method forward or Move the selected method backward.

OR

In Method Selection, right-click on the desired detection or preparation method 
and choose Move Up or Move Down.

9. To delete a detection or preparation method from the protocol, in Method 
Selection, select the method to be deleted and choose Delete the selected 
method from this protocol.

OR

In Method Selection, right-click on the desired detection or preparation method 
and choose Remove Method.
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10. Choose Next to configure Output Settings (refer to Section 5.2.6, Configuring 
Output Settings). 

OR

Choose Back to change Labware Layout Settings (refer to Section 5.2.4, 
Configuring Labware Layout Settings).

OR

Choose Cancel to close Create Protocol without saving the new protocol.

5.2.5.2.1 Configuring a Shake Preparation Method
A Shake preparation method shakes the microplate at the point in the execution 
sequence where it is positioned. For example, Figure 5-12 shows a protocol where the 
microplate is shaken before absorbance measurements are performed at three 
wavelengths.

Note:  A Shake preparation method only shakes the plate once for the configured 
duration and intensity. To perform interval shaking between each cycle in a kinetic 
measurement, shaking must be configured in Method Properties for the desired 
detection method (refer to Section 5.2.5.1, Configuring a Method in Basic Mode).

To configure a Shake preparation method:

1. In Method Selection, choose the desired Shake preparation method. Method 
Properties for the selected method appear (Figure 5-12).

Figure 5-12.  Configuring a Shake preparation method

CAUTION: Shake low density plates, such as 6- or 48-well plates, at low 
speed only. Shaking low density plates at higher speeds may cause 
liquid in wells to spill.
2. In Shake Intensity, select the desired intensity of shaking: Low, Medium, or 

High.
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3. In Shake Interval, enter the length of time in seconds (0–60) to shake the 
microplate.

4. In Shake Mode, select the desired shaking pattern.

• Linear — shakes from side to side.

• Orbital — shakes labware in a circular pattern.

• Squared — shakes labware in a square pattern, moving at right angles.

 
5. To move the Shake preparation method to a different location in the execution 

sequence, in Method Selection, select the method and choose Move the 
selected method forward or Move the selected method backward.

OR

In Method Selection, right-click on the Shake preparation method and choose 
Move Up or Move Down.

5.2.5.2.2 Configuring a Set Temperature Preparation 
Method (880 only)

A Set Temperature preparation method sets the temperature inside the microplate 
chamber. The temperature is set by heating the microplate chamber; cooling the 
chamber is not supported by the instrument. Depending on the measurement 
wavelength and light source used in the protocol, the set temperature may range from 
3°C (5.4°F) or 4°C (7.2°F) above ambient to 45°C (113°F).

It takes a minimum of 30 minutes for the instrument to reach the desired temperature. 
The actual time required depends on the relative change in temperature. When a 
protocol with a Set Temperature preparation method is run, the protocol does not 
pause to wait for the desired temperature to be reached. To set an exact temperature 
before starting a protocol run, use Manual Control to set the temperature and check it 
at regular intervals until the desired temperature is reached (refer to Section 2.3.3.1, 
Temperature Control (880 only)). 

Note:  Set Temperature preparation methods are useful for kinetic measurements 
intended to measure the effects of temperature changes on samples.
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To configure a Set Temperature preparation method:

1. In Method Selection, choose the desired Set Temperature preparation 
method. Method Properties for the selected method appear (Figure 5-13).

Figure 5-13.  Configuring a Set Temperature preparation method

2. In Set Temperature, enter the desired microplate chamber temperature in 
degrees Celsius. In protocols that perform measurements only at visible 
wavelengths (>369 nm), the minimum temperature that may be set is 3°C (5.4°F) 
above ambient. When the protocol performs measurements in the UV band using 
the deuterium lamp, the minimum temperature is 4°C (7.2°F) above ambient. The 
maximum temperature that may be set is 45°C (113°F).

Note:  The temperature remains at the current setting until overridden by another 
Set Temperature preparation method, by changing the temperature in Manual 
Control, or by turning the instrument off and on.

 
3. To move the Set Temperature preparation method to a different location in the 

execution sequence, in Method Selection, select the method and choose Move 
the selected method forward or Move the selected method backward.

OR

In Method Selection, right-click on the Set Temperature preparation method 
and choose Move Up or Move Down.
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5.2.6 Configuring Output Settings
Use Output Settings to configure how measurement results are saved and/or printed 
after a protocol run (Figure 5-14). Options available include choosing to export 
results and automatically open them in Microsoft® Excel following a protocol run, 
choosing the file formats used to save measurement results, and configuring which 
protocol information and measurement results are included in printouts. An external 
software application, such as a database, may also be configured to execute after a 
protocol run.

Figure 5-14.  Configuring output settings

To configure Output Settings:

1. Choose Excel, data file, and print output options as desired. Table 5-1 describes 
the options available.

2. Choose Run this protocol now before saving to run the protocol 
immediately. Refer to Section 5.3, Running Protocols, for more information 
about running protocols.

3. Choose Execute a program after protocol executes to display options for 
configuring an external software application to run immediately after the 
protocol run is completed. Refer to Section 5.2.6.1, Configuring a Program to 
Run after Protocol Executes, for more information.

4. Choose Save to save the protocol and close Create Protocol.

OR

Choose Cancel to close Create Protocol without saving the new protocol.

OR

Choose Back to configure methods used in the protocol (refer to Section 5.2.5, 
Configuring Detection and Preparation Methods).

File format options

Excel export 

Print options

Run protocolExecute program
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Table 5-1.  Output Options
Output Option Description

Export to Microsoft® Excel
Perform after completing 
measurement(s)

Saves results in a format compatible with Microsoft® 
Excel, and automatically opens Excel when the protocol 
run is completed.

Note:  Versions of Excel prior to Office 2000 are not 
supported by the Export to Microsoft Excel function, 
but can open measurement results stored in tab-delimited 
data (.dat) files.

Create .XML and .dat data files
Perform after completing 
measurement(s)

Automatically exports measurement results to a tab-
delimited data (*.dat) file and an XML file. These files 
may be opened by software applications compatible with 
tab-delimited data or XML files.

Note:  The directory where the data files are saved is 
configured in System Settings. Refer to Section 1.4.2.4, 
Choosing the Directory Where Measurement Results are 
Saved.

Print options
Perform after completed 
measurement(s)

Automatically prints the results after completing a 
protocol run. This option must be selected to print 
measurement results.

Raw Data Prints raw data measured for each sample. For kinetic 
measurements, prints raw data measured in each cycle. 
For scan measurements, prints raw data for all 
measurement points.

Note:  Printing kinetic and scan measurement results 
may require numerous pages, depending on the number 
of measurement cycles performed or points measured.

Protocol Information Prints the name of the protocol underneath the printout 
header.

Labware Information Prints information about the labware used, including 
plate type, number of wells measured, lot name, and the 
date that the lot was optimized.

General Information Prints general information about the protocol including 
when the protocol was created or last edited and 
performed.

Plate Graph Prints graphs of kinetic and scan measurement results. 
Only available for configuration when a kinetic, area 
scan, or linear scan measurement is configured in the 
protocol.

Method Information Prints information about the detection method(s) used in 
the protocol.
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5.2.6.1 Configuring a Program to Run after Protocol 
Executes

Output Settings can be configured to open an external software application, such as 
a custom data logger or database, after completing a protocol run. If the selected 
application supports entering commands using a command line interface, a specific 
command for the application may also be configured.

To configure a program to run after a protocol is executed:

1. In Output Settings, choose Execute a program after protocol executes. 
Execute Program expands to show the fields that may be configured (Figure 
5-15).

Figure 5-15.  Configuring an external software application in Output Settings

2. In Execute Program, enter the complete path of the program to run; for 
example, C:\Program Files\Data Logger\MyCustomDataLogger.exe.

OR

Choose Browse to find an executable program. Open appears.

3. In Open, browse to the location of the desired application and select it.

4. Choose Open to return to Output Settings. The selected path appears in 
Execute Program.

OR

Choose Cancel to close Open without selecting an application.

5. If the selected application supports command line parameters, in Command line 
parameter, enter the desired parameter.

Execute 
program
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5.3 Running Protocols
Saved protocols may be accessed and run at any time, either on an instrument or in 
simulation mode. The run options available are different for each mode. For more 
information, refer to:

• Running a Protocol on an Instrument (Section 5.3.1).

• Running a Protocol When Simulation Mode is Enabled (Section 5.3.2).

5.3.1 Running a Protocol on an Instrument
Running a protocol on an instrument performs measurements on samples and outputs 
results data following the parameters configured in the protocol.

To run a protocol on an instrument:

1. In the Protocol Selection List, select the protocol to run.

2. From the toolbar, choose Run the selected protocol.

OR

From the Actions menu, choose Run the selected protocol.

OR

Right-click on the selected protocol and choose Run the selected protocol 
from the menu. Prepare to Run Protocol appears (Figure 5-16).

Figure 5-16.  Preparing to run a protocol on an instrument

3. Use Eject Plate Carrier and Close Plate Carrier to load the microplate into 
the instrument, if necessary.

Optimize Read Height
Only available for the DTX 880.
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4. Select the orientation that matches how the plate is positioned on the plate 
carrier:

• Landscape — the long edges of the plate run parallel to the front of 
the instrument, with well A1 located in the upper left corner.

• Portrait — the short edges of the plate run parallel to the front of the 
instrument, with well A1 located in the upper right corner.

• Opposite Landscape — the edges of the plate run parallel to the 
front of the instrument, with well A1 located in the lower right corner.

• Opposite Portrait — the short edges of the plate run parallel to the 
front of the instrument, with well A1 located in the lower left corner.

Note:  Well A1 is identified in the plate graphic by a red highlight.

5. When preparing to run a fluorescence top, fluorescence polarization, or time-
resolved (TRF) protocol, choose Optimize Read Height to automatically 
determine and set the optimal read height used in the protocol run (refer to 
Section 5.3.1.1, Optimizing Read Height (880 only)). 

DTX 880 — Optimize Read Height is available for this instrument only.

OR

Select the read height manually:

• Default — uses the read height defined in Labware Information for the 
labware type used in the protocol (refer to Section 4.2.1, Defining Labware 
Information).

• Maximum — sets the read height at 10.6 mm, the maximum height 
supported by the instrument.

• Set Value — manually sets the reading height using the adjacent 
configuration field. Setting the reading height manually is useful when the 
height determined by a prior optimization for the same labware type is 
known.

6. Choose Run or Next to run the protocol.

OR

Choose Cancel to close Run Protocol without running the protocol.
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5.3.1.1 Optimizing Read Height (880 only)
The DTX 880 features an objective lens that may be moved up and down to optimize 
the read height used in fluorescence intensity top, fluorescence polarization, and time-
resolved fluorescence protocols. Read height is the distance between the top surface 
of the microplate being read and the lower surface of the objective lens. Optimizing 
read height matches the focus of the optics with the sample volume. This maximizes 
the raw signal, which yields the highest precision and maximum sensitivity.

Read height is optimized using the Read Height Optimization Wizard (Figure 
5-17). A single sample with a known maximum signal is placed on the same type of 
microplate used in the protocol. The sample is measured using the same, or very 
similar, detection method used in the protocol.

The optimized read height is saved in the protocol and is used for all subsequent runs 
of the protocol until reset by performing a new optimization or manually selecting a 
read height option.

To optimize read height:

1. In Run Protocol, select Optimize Read Height. The Read Height 
Optimization Wizard appears (Figure 5-17).

Figure 5-17.  Selecting the detection method used in the read height optimization

2. In Select Detection Method, select the detection method used in the 
optimization. For fluorescence top protocols, choose the same detection method 
used in the protocol. For fluorescence polarization and time-resolved 
fluorescence protocols, choose the detection method that is the closest match to 
that used in the protocol.

3. Choose Next to select the well measured to perform the optimization. Prepare 
Labware appears (Figure 5-18).

OR

Choose Cancel to close the wizard without performing the optimization.
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4. Pipette liquid with a known maximum signal to a single well on the microplate 
used in the optimization. The liquid volume of the optimization sample should be 
the same as that of samples measured in the protocol.

5. Load the plate into the instrument.

Figure 5-18.  Selecting the well read in the read height optimization

6. In Prepare Labware, select the well containing the optimization sample (Figure 
5-18).

7. Choose Next to start the optimization. Optimization in Progress appears 
(Figure 5-19). The optimization may take several minutes.

OR

Choose Back to change the detection method used in the calibration.

OR

Choose Cancel to close the wizard without performing the optimization.

Select the well containing 
the optimization sample.
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Figure 5-19.  Read height optimization in progress

8. While the optimization is in progress, choose Cancel to stop the optimization 
read and close the wizard, if desired. When the read is finished, Optimization 
Complete appears, displaying the Optimized Read Height (Figure 5-20).

Figure 5-20.  Read height optimization completed

9. In Optimization Complete, choose Save to save the optimized read height in 
the protocol. The optimized read height is used for all subsequent runs of the 
protocol until reset by performing a new optimization or manually selecting a 
read height option.

OR

Choose Cancel to close the wizard without saving and using the optimized read 
height in the protocol run.
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5.3.2 Running a Protocol When Simulation Mode 
is Enabled

Running a protocol in simulation mode allows the protocol configuration to be tested 
using simulated data before performing the protocol on actual samples. Simulated 
data is either generated randomly or read from a file.

Simulation mode is automatically enabled when the host computer is not connected to 
an instrument. When an instrument is connected, simulation mode may be enabled 
manually in Instruments (refer to Section 2.2.5, Enabling Simulation Mode).

To run a protocol in simulation mode:

1. In the Protocol Selection List, select the protocol to run.

2. From the toolbar, choose Run the selected protocol.

OR

From the Actions menu, choose Run the selected protocol.

OR

Right-click on the selected protocol and choose Run the selected protocol 
from the menu. Prepare to Run Protocol appears (Figure 5-21).

Figure 5-21.  Preparing to run a protocol in simulation mode

3. Select Check to generate random data to run the protocol using random 
data generated by the software, if desired.

Directory path of 
simulated data file
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4. In Use this Data Simulation file for this read:

• Leave the directory path of the simulated data path as configured to use 
the data file selected in Software Settings (refer to Section 1.4.2.3, 
Choosing Simulated Data Files).

• Enter the directory path of the desired data file. The complete directory 
path must be entered; for example, c:\program files\Beckman 
Coulter multimode reader\simulations\simulated absorbance 
data.dat.

• Browse to the location where the desired data file is saved and select it.

Note:  Results from prior measurements saved in .dat format may be used as 
simulated data files (refer to Section 5.2.6, Configuring Output Settings). 
Simulated data files are used when the number of measurement points in the 
simulated protocol run is the same as those present in the data file. When the 
number of measurement points is different, the software generates random data.

When a different simulated data file is selected in Prepare to Run Protocol, the 
file is used for the current simulated run only. After the simulated run has 
finished, the data file defaults to the file selected in Software Settings (refer to 
Section 1.4.2.3, Choosing Simulated Data Files).

5. Choose Run or Next to run the selected protocol.

OR

Choose Cancel to close Run Protocol without running the protocol.
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5.4 Editing Protocols
The parameters configured for user-defined protocols may be edited. Default 
protocols included with the software installation may not be edited.

To edit a protocol:

1. In the Protocol Selection List, select the protocol to edit.

2. From the toolbar, choose Edit the selected protocol.

OR

From the Actions menu, choose Edit the selected protocol.

OR

Right-click on the selected protocol and choose Edit the selected protocol 
from the menu.

OR

Double-click on the selected protocol. Edit Protocol appears (Figure 5-22).

Figure 5-22.  Editing an absorbance protocol

3. Edit the parameters in each Edit Protocol screen as desired.

Note:  Refer to Section 5.2, Creating Protocols, for detailed information about 
configuring protocol parameters.

4. Choose Save to close Edit Protocol and save the changes.

OR

Choose Cancel to close Edit Protocol without saving changes.
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5.5 Copying Protocols
Copies may be made of existing protocols. After a copy has been created, it may be 
used as a template for a new protocol using the same technique.

To make a copy of a protocol:

1. In the Protocol Selection List, select the protocol to copy.

2. From the toolbar, choose Make a copy of the selected protocol.

OR

From the Actions menu, choose Make a copy of the selected protocol.

OR

Right-click on the selected protocol and choose Make a copy of the selected 
protocol from the menu. A copy of the selected protocol appears in the 
Protocol Selection List.

Note:  The default name format for copied protocols is Copy of OriginalName. 
To change the name, open the protocol for editing and enter the new protocol 
name (refer to Section 5.4, Editing Protocols).
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5.6 Deleting Protocols
User-defined protocols that are no longer used to perform measurements may be 
deleted from the Protocol Selection List. Default protocols included with the 
software installation may not be deleted.

To delete a user-defined protocol:

1. In the Protocol Selection List, select the protocol to delete.

2. From the toolbar, choose Delete the selected protocol.

OR

From the Actions menu, choose Delete the selected protocol.

OR

Right-click on the selected protocol and choose Delete the selected protocol 
from the menu. Message appears (Figure 5-23).

Figure 5-23.  Confirming the deletion of a protocol

3. Choose Yes to delete the selected protocol.

OR

Choose No to cancel the deletion.



Defining, Editing, and Running Protocols 5-31

Multimode Detection Software User’s Manual

5.7 Printing Protocol Configuration Information
Information about the protocol configuration and sample layout may be printed 
separately from measurement results. 

To print protocol configuration information:

1. In the Protocol Selection List, select the protocol to print.

2. From the toolbar, choose Print the selected protocol.

OR

From the Actions menu, choose Print the selected protocol.

OR

Right-click on the selected protocol and choose Print the selected protocol 
from the menu. 

Note:  Depending on how Print Settings are configured, Print and/or Print 
Preview may appear before the protocol configuration prints. Refer to Section 
1.4.2.2, Configuring Print Settings, for more information about enabling and 
disabling Print and Print Preview.
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3. If Print and Print Preview are not enabled in Print Settings, no additional 
configuration is required. The protocol configuration and layout of samples on 
the plate prints.

OR

If Print appears, configure printing options as desired and choose OK.

OR

If Print Preview appears, use the toolbar controls to change the magnification, 
layout view, or page(s) displayed, if desired (Figure 5-24).

Figure 5-24.  Previewing a protocol configuration and sample layout printout

4. In Print Preview, choose Print to print out the measurement results.

5. In Print Preview, choose Close to close the window.

Note:  Choosing Close without first choosing Print cancels the printout.

Change page(s) 
displayed

Change view 
magnification

Change 
layout view
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5.8 Exporting and Importing Protocols
User-defined protocols saved in the Protocol Selection List can be exported to an 
XML file and imported later to restore that configuration or share it with a copy of 
Multimode Detection Software installed on another computer. An exported XML file 
also saves detection method(s) and labware configurations used in the protocol.

Exporting default protocols included with the software installation is not necessary. 
Since default protocols may not be edited, deleted, or overwritten, they are always 
available to users at all times. Because of this, importing a default protocol from an 
XML export file is not permitted by the software.

To export a protocol:

1. In the Protocol Selection List, select the protocol to export. 

2. From the File menu, choose Export>Protocol. Browse for Folder appears 
(Figure 5-25).

Figure 5-25.  Choosing the folder where an exported protocol will be saved

3. In Browse for Folder, browse to the folder where the exported protocol will be 
saved.

OR

Choose Make New Folder to create a new folder where the exported protocol 
will be saved.

4. Choose OK to export the protocol. The exported protocol is saved using the 
default file name format, Protocol_ProtocolName.xml. In order to import the 
file at a later date, the filename must not be changed.

OR

Choose Cancel to stop the operation without exporting the protocol.
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To import a protocol from an exported XML file:

1. From the File menu, choose Import>Protocol. Open appears.

2. In Open, browse to and select the desired XML file to import.

3. Choose Open. The protocol, as well as detection method(s) and labware used in 
the protocol, are imported. Any default detection method(s) or labware used in 
the protocol are not imported because default methods and labware may not be 
edited, deleted, or overwritten. Instead, the imported protocol uses the same 
default methods and labware stored in the software.
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6 Viewing Measurement Results

6.1 Overview
Multimode Detection Software displays measurement results in a series of tabs within 
Run Protocol (Figure 6-1). Raw data is displayed immediately after each column or 
row is read. All measurements display sample status and raw data; kinetic and scan 
measurements also display graphs for each sample. Detection methods and 
measurement cycles performed in the protocol are displayed in the left pane of the 
tab; results are displayed in the right pane. The tabs may be viewed until Finish is 
chosen.

Figure 6-1.  Measurement results displayed after a protocol run
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When Finish is chosen, Run Protocol closes and results are exported and printed 
according to the file and printing options defined in the protocol (refer to Section 
5.2.6, Configuring Output Settings). When no file or printing options are defined, 
measurement results are deleted and may not be recovered.

Measurement results are exported to the data directory specified in System Settings 
(refer to Section 1.4.2, Configuring Software Settings). Exported results may be 
viewed, edited, evaluated, and printed using Microsoft® Excel or other applications 
compatible with the file format of the exported data. Multimode Detection Software 
does not provide the ability to open, view, or evaluate exported results.

This chapter covers:

• Viewing Measurement Results in Run Protocol (Section 6.2).

• Viewing Exported Measurement Results (Section 6.3).

• Printing Measurement Results (Section 6.4).
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6.2 Viewing Measurement Results in Run Protocol
Measurement results are displayed in a series of tabs within Run Protocol:

• State — displays which samples were measured successfully and which 
were not because of errors during the measurement (refer to Section 6.2.1, 
Viewing State).

• Raw Data — displays actual values measured. For kinetic measurements, 
results are displayed for each measurement cycle. For linear and area scan 
measurements, results are displayed for each measurement point (refer to 
Section 6.2.2, Viewing Raw Data).

• Graphs — displays graphs of measurement data for kinetic and scan 
measurements only (refer to Section 6.2.3, Viewing Kinetic and Scan 
Graphs).

6.2.1 Viewing State
State displays which samples were measured successfully and which were not 
because of errors during the measurement (Figure 6-2):

• OK — sample measured successfully.

• Error — sample not measured because an instrument error occurred.

• Overflow — no results available because the value measured exceeds the 
upper measurement limit.

• Incorrect — sample was measured, but is incorrect because an instrument 
error occurred.

• Unused — sample not selected for measurement in the protocol.

Figure 6-2.  State displayed for an area scan measurement
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To view State of samples or measurement points:

1. If necessary, in the left panel of the tab, click the + next to the desired detection 
method to expand the view and access measurement cycles (Figure 6-2). 

2. For absorbance, luminescence, and fluorescence measurements, select the 
desired measurement cycle. The status of each sample measured in the cycle 
appears in the right pane.

OR

For linear and area scan measurements, choose the desired sample. The status of 
each measurement point for the chosen sample appears in the right pane.

3. Choose a different cycle or sample to view.

OR

Choose a different results tab to view.

OR

Choose Finish to close Run Protocol. Measurement results are saved and/or 
prepared for printing when file and print options are defined in the protocol (refer 
to Section 5.2.6, Configuring Output Settings).

6.2.2 Viewing Raw Data
Raw Data displays the results for each sample or point measured in every cycle 
(Figure 6-3).

Figure 6-3.  Raw Data displayed for a kinetic absorbance measurement
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To view Raw Data of samples or measurement points:

1. If necessary, in the left panel of the tab, click the + next to the desired detection 
method to expand the view and access measurement cycles (Figure 6-3).

2. For absorbance, luminescence, and fluorescence measurements, select the 
desired measurement cycle. Raw data measured for each sample in the cycle 
appears in the right pane.

OR

For linear and area scan measurements, choose the desired sample. Raw data 
measured at each point within the chosen sample appears in the right pane.

3. If desired, right-click on the raw data results and choose Copy to copy the raw 
data values to the clipboard. The values may then be pasted into another 
document or file.

4. Choose a different cycle or sample to view.

OR

Choose a different results tab to view.

OR

Choose Finish to close Run Protocol. Measurement results are saved and/or 
prepared for printing when file and print options are defined in the protocol (refer 
to Section 5.2.6, Configuring Output Settings).
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6.2.3 Viewing Kinetic and Scan Graphs
Graphs displays graphs for each sample measured in kinetic, area scan, and linear 
scan protocols (Figure 6-4). The tab is not displayed unless a kinetic or scan 
measurement is performed.

Figure 6-4.  Viewing area scan measurement graphs

Graphs for individual samples can be viewed in detail. To view a detailed graph of an 
individual sample:

Click on the desired sample to view. Graphic View appears (Figure 6-5). Refer 
to Section 6.2.3.1, Viewing Detailed Graphs of Individual Samples, for more 
information about viewing and printing detailed graphs.

To exit Graphs:

Choose a different results tab to view.

OR

Choose Finish to close Run Protocol. Measurement results are saved and/or 
prepared for printing when file and print options are defined in the protocol (refer 
to Section 5.2.6, Configuring Output Settings).
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6.2.3.1 Viewing Detailed Graphs of Individual Samples
Graphic View displays a detailed graph of the measurement results for an individual 
sample. Two types of graphs are available:

• Area scan measurements display a three-dimensional graph that may be 
rotated horizontally and vertically (refer to Section 6.2.3.1.1, Viewing and 
Printing an Area Scan Graph).

• Kinetic and linear scan measurements display a two-dimensional graph that 
may be zoomed (refer to Section 6.2.3.1.2, Viewing and Printing a Kinetic or 
Linear Scan Graph).

6.2.3.1.1 Viewing and Printing an Area Scan Graph
Area scan measurements display a three-dimensional graph with the optical density 
(OD) of all points measured color coded (Figure 6-5). The graph may be rotated 
horizontally and vertically and printed.

Figure 6-5.  Three-dimensional area scan graph

To rotate the graph:

• Use the vertical scroll bar to rotate the graph vertically.

• Use the horizontal scroll bar to rotate the graph horizontally.

• Double-click on the graph to start and stop a continuous animated horizontal 
rotation of the graph. 

To print the graph:

1. From the File menu, choose Print. Print appears.

2. Configure printing options as desired, and choose OK to print the graph.

To close Graphic View:

From the File menu, choose Close.

Use the vertical scroll bar to 
rotate the graph vertically.

Use the horizontal scroll bar to 
rotate the graph horizontally.
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6.2.3.1.2 Viewing and Printing a Kinetic or Linear Scan 
Graph

Kinetic and linear scan measurements display a two-dimensional graph tracking the 
optical density (OD) measured in each cycle or at each point (Figure 6-6). Two-
dimensional graphs support zooming in on selected regions and printing.

Figure 6-6.  Two-dimensional kinetic graph with zoom region selected

To zoom in on a region:

1. Position the cursor at the desired starting point for the region, then click and hold 
the mouse button down.

2. Drag the mouse until the desired region is selected (Figure 6-6). The selected 
region is highlighted in black.

3. Release the mouse button. Graphic View displays the zoomed view of the 
selected region.

To print the graph:

1. From the File menu, choose Print. Print appears.

2. Configure printing options as desired, and choose OK to print the graph.

To close Graphic View:

From the File menu, choose Close.

Selected region 
to zoom
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6.3 Viewing Exported Measurement Results
When a protocol has export and/or data file options configured in Output Settings, 
measurement results are exported after completing a protocol run. Exported results 
are always opened, viewed, and evaluated in a compatible software application, such 
as Microsoft® Excel. Multimode Detection Software only provides the ability to view 
results before they are exported.

Two file export and save options are available:

• Export to Microsoft Excel — saves results in a format compatible with 
Microsoft Excel, and automatically opens Excel when the protocol run is 
completed. Refer to Section 6.3.1, Viewing Measurement Results Using 
Microsoft® Excel, for more information about viewing exported results in 
Excel.

Note: Multimode Detection Software automatically determines the 
appropriate export method based on the version of Microsoft Office installed 
on the host computer. XML (.xml) files are exported when Office XP is 
installed. When Office 2000 installed, the measurement results are copied 
into a new spreadsheet which must be saved in Excel. Versions of Excel 
prior to Office 2000 are not supported by the Export to Microsoft Excel 
function, but can open measurement results stored in tab-delimited data 
(.dat) files.

• Create .XML and .dat data files — saves results in .xml and tab-delimited 
data (.dat) files, which may be opened by compatible software applications.

Note:  Refer to Section 5.2.6, Configuring Output Settings, for more information 
about configuring export and file options.

To view saved measurement results:

1. Open the desired software application.

2. Browse to the directory where exported measurement results are stored, and open 
the desired file. Saved measurement results are stored in the data directory 
selected in Software Settings (refer to Section 1.4.2.4, Choosing the Directory 
Where Measurement Results are Saved). 

6.3.1 Viewing Measurement Results Using 
Microsoft® Excel

When Export to Microsoft Excel is defined in the protocol, protocol information and 
measurement results are exported to a file and automatically opened in Excel after 
completing a protocol run. Each exported Excel spreadsheet contains data for a single 
protocol run. Data is presented in a series of worksheets. The first worksheet, 
General, contains information about the protocol (refer to Section 6.3.1.1, Viewing 
Information About the Protocol). Raw data is contained in separate worksheets for 
each measurement cycle (refer to Section 6.3.1.2, Viewing Measurement Results). 
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6.3.1.1 Viewing Information About the Protocol
General, the first worksheet in all Excel files exported by Multimode Detection 
Software, contains information about parameters configured in the protocol and the 
protocol run itself (Figure 6-7).

Figure 6-7.  Viewing protocol information in the General worksheet (excerpt)

To view the General worksheet:

In Excel, choose the General tab in the lower left corner of the window.
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6.3.1.2 Viewing Measurement Results
Measurement results exported to Excel display raw data in matrices that represent the 
layout of measured wells on the plate (Figure 6-8). When multiple measurement 
cycles were performed in a protocol run, data from each cycle is presented in a 
separate worksheet.

DTX 880 — Fluorescence polarization measurement results contain raw 
data and calculated mP (refer to Section 6.3.1.2.1, Viewing Fluorescence 
Polarization Results (880 only)).

Figure 6-8.  Viewing absorbance data in a Cycle worksheet (excerpt)

To view results for a measurement cycle:

In Excel, choose the Cycle tab for the desired measurement cycle.
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6.3.1.2.1 Viewing Fluorescence Polarization Results 
(880 only)

Fluorescence polarization measurement results exported to Excel contain raw data 
measured at both the parallel and perpendicular polarization planes and calculate an 
approximate mP for each sample (Figure 6-9). Data is laid out in matrices that 
represent the wells on the plate. When multiple measurement cycles were performed 
in a protocol run, data from each cycle is presented in a separate worksheet.

The mP calculated for each sample is considered approximate because:

• Blank samples are not defined at run time, but are required to increase the 
accuracy of the results.

• The G-factor used in the calculation, which factors out differences in 
detection efficiency between the polarization planes, is derived from 
fluorescein measurements performed on a number of DTX 880 instruments. 

Note: Minor deviations between the actual G-Factor present in the 
measurement and the average G-factor used in the calculation result in a 
common shift for all mP values measured. Differences in mP between 
samples and controls are not affected to a first order approximation. If a 
more accurate G-factor has been determined for the instrument, it may be 
entered in the G-factor cell in the spreadsheet.

Figure 6-9.  Viewing fluorescence polarization data (excerpt)
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6.4 Printing Measurement Results
When a protocol has Print options configured in Output Settings, the measurement 
results are available to print after completing a protocol run. Refer to Section 5.2.6, 
Configuring Output Settings, for information about the printing options available.

Note:  Depending on how Print Settings are configured, Print and/or Print Preview 
may appear before the measurement results print. Refer to Section 1.4.2.2, 
Configuring Print Settings for information about enabling and disabling Print and 
Print Preview.

To print measurement results:

1. When the measurement is complete, press Finish. If Print and Print Preview 
are not enabled in Print Settings, no additional configuration is required. The 
measurement results print out.

2. If Print appears, configure printing options as desired and choose OK.

OR

If Print Preview appears, use the toolbar controls to change the magnification, 
layout view, or page(s) displayed, if desired (Figure 6-10)

Figure 6-10.  Previewing a measurement results printout
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3. In Print Preview, choose Print to print out the measurement results.

4. In Print Preview, choose Close to close the window.

Note:  Choosing Close without first choosing Print cancels the printout.
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A Appendix A: Software Error 
Codes

A.1 Troubleshooting Software Error Codes
Table A-1 lists software error codes, error messages, and recommended solutions for 
resolving errors.

Table A-1.  Software Error Codes and Solutions
Error
Code

Error Message Recommended Solution

1 Commanded transport motion exceeds actual 
physical travel limits.

Check plate parameters configured in 
Labware Information (refer to Section 4.2.1, 
Defining Labware Information).

3 Auto calibration ramp parameter exceeds valid 
range.

Make sure the microplate carrier movement is 
not obstructed and run the measurement again.

4 Transport is not operational or the transport 
sensor is defective.

Make sure the transport lock has been removed 
from the microplate carrier.

5 Transport lost more than 2 full steps. Make sure the microplate carrier movement is 
not obstructed.

6 Calibration positioning failed. N/A
7 Offset calculated in auto calibration is out of 

expected range. Possible causes: ADC values 
are too low, lamp is not adjusted, incorrect 
EEPROM parameters.

Check filter parameters configured in 
Instrument Settings (refer to Section 2.3.2, 
Defining and Editing Filter Slides).

8 Offset calculated in auto calibration is out of 
expected range. Possible causes: ADC values 
are too low, lamp is not adjusted, incorrect 
EEPROM parameters.

Contact a Beckman Coulter Service Engineer.

9 Z-transport adjust error. Possible causes: 
wrong well for adjustment, low fluorescein 
concentration.

In the Read Height Optimization Wizard, 
confirm that the correct well is selected for the 
optimization read (refer to Section 5.3.1.1, 
Optimizing Read Height (880 only)).

10 Measurement attempted with no labware 
loaded.

Load a plate into the instrument.
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11 The current labware definition is invalid. Check plate parameters configured in 
Labware Information (refer to Section 4.2.1, 
Defining Labware Information).

12 Detection method parameters are invalid. Check the configuration of detection method 
parameters.

13 The current labware format is not supported. Make sure the plate type has been defined 
(refer to Section 4.2, Creating Labware). 

14 Currently loaded labware is not in the correct 
orientation.

Load the plate into the instrument with the 
orientation configured in the protocol.

16 Linear scan range exceeds well diameter. Reduce the number of measurement points in 
the scan configuration (refer to Section 5.2.5.1, 
Configuring a Method in Basic Mode).

21 Bright measurement below limit. Check 
Platedefinition.

Check plate parameters configured in 
Labware Information (refer to Section 4.2.1, 
Defining Labware Information).

41 Filter wavelength or filter type in current 
detection method is not installed.

Check filter parameters configured in 
Instrument Settings (refer to Section 2.3.2, 
Defining and Editing Filter Slides).

42 Filter wavelength in command is not defined in 
any Slide.

Check filter parameters configured in 
Instrument Settings (refer to Section 2.3.2, 
Defining and Editing Filter Slides).

44 Currently inserted slide code does not match 
set slide code. Reinsert slide.

Make sure the correct filter slides are installed 
in the instrument.

46 No filter slide detected. Make sure filter slides are installed.
47 Currently inserted filter slide code is invalid. Make sure the correct filter slides are installed 

in the instrument.
48 Currently inserted filter slide contains no valid 

defined filters.
Make sure the correct filter slides are installed 
in the instrument and check filter parameters 
configured in Instrument Settings (refer to 
Section 2.3.2, Defining and Editing Filter 
Slides).

51 Temperature setpoint exceeds 45ºC/113ºF. Check the temperature set in Manual Control 
and/or the protocol. Set a desired temperature 
less than 45ºC, if necessary (refer to Section 
2.3.3.1, Temperature Control (880 only)).

60 Currently inserted LED is not defined. Contact a Beckman Coulter Service Engineer.
61 LED causing ADC overflow. Make sure the correct filter slides are installed 

in the instrument and check filter parameters 
configured in Instrument Settings (refer to 
Section 2.3.2, Defining and Editing Filter 
Slides).

Table A-1.  Software Error Codes and Solutions
Error
Code

Error Message Recommended Solution
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62 LED energy too low. Make sure the correct filter slides are installed 
in the instrument and check filter parameters 
configured in Instrument Settings (refer to 
Section 2.3.2, Defining and Editing Filter 
Slides).

63 No LED for selected filter installed. Contact a Beckman Coulter Service Engineer.
64 ADC gain cannot be maintained Contact a Beckman Coulter Service Engineer.
65 LED gain setting failed. Contact a Beckman Coulter Service Engineer.
66 ADC gain fluctuated during measurement, 

correction of PMT counts is not possible. Try 
measurement again.

Run the measurement again.

67 Reference ADC too high for valid 
luminescence measurement.

Make sure the filter compartment and 
microplate chamber doors are closed.

68 PMT dark counts exceed valid range for 
measurement. Check threshold or ensure that 
flaps are closed.

Make sure the filter compartment and 
microplate chamber doors are closed.

69 Reference ADC LED too low, retry 
measurement.

Run the measurement again.

140 Command canceled. Aborted by user. N/A
141 Measurement time exceeds limit for current 

measurement method.
Use a shorter measurement time in the 
detection method configuration.

142 Current measurement incomplete, wrong 
command received.

Check the parameters configured in the 
protocol.

144 Instrument is busy. Wait until the amber LED on the instrument is 
off. If instrument is still busy when the LED is 
off, turn the instrument off and on.

400 Unknown PIC error. Contact a Beckman Coulter Service Engineer.
401 Communication timeout with PIC controller. Contact a Beckman Coulter Service Engineer.
403 PIC timeout during a measurement or 

initialize.
Contact a Beckman Coulter Service Engineer.

410 Number of steps are zero. Check the parameters configured in the 
protocol.

411 LED transport commanded to move to a 
position less than 0.

Contact a Beckman Coulter Service Engineer.

412 Shutter transport commanded to move to a 
position less than 0.

Contact a Beckman Coulter Service Engineer.

413 Z transport commanded to move to a position 
less than 0.

Contact a Beckman Coulter Service Engineer.

415 LED transport commanded to move to a 
position greater than maximum travel.

Contact a Beckman Coulter Service Engineer.

416 Shutter transport commanded to move to a 
position greater than maximum travel.

Contact a Beckman Coulter Service Engineer.

Table A-1.  Software Error Codes and Solutions
Error
Code

Error Message Recommended Solution
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417 Z transport commanded to move to a position 
greater than maximum travel.

Contact a Beckman Coulter Service Engineer.

419 LED transport initialization failed. Contact a Beckman Coulter Service Engineer.
420 Shutter transport initialization failed Contact a Beckman Coulter Service Engineer.
421 Z transport initialization failed Contact a Beckman Coulter Service Engineer.
423 LED transport lost steps. Contact a Beckman Coulter Service Engineer.
424 Shutter transport lost steps. Contact a Beckman Coulter Service Engineer.
425 Z transport lost steps. Contact a Beckman Coulter Service Engineer.
427 LED transport is not energized Initialize the instrument (refer to Section 2.2.3, 

Initializing the Instrument).
428 Shutter transport is not energized Initialize the instrument (refer to Section 2.2.3, 

Initializing the Instrument).
429 Z transport is not energized Initialize the instrument (refer to Section 2.2.3, 

Initializing the Instrument).
431 LED transport error while positioning. Contact a Beckman Coulter Service Engineer.
432 Shutter transport error while positioning. Contact a Beckman Coulter Service Engineer.
433 Z transport error while positioning. Contact a Beckman Coulter Service Engineer.
440 LED number is out of valid range (0-15). Contact a Beckman Coulter Service Engineer.
441 LED not initialized Contact a Beckman Coulter Service Engineer.
442 The LED is not powered. Contact a Beckman Coulter Service Engineer.
443 The LED has exceeded maximum allowed 

power consumption.
Contact a Beckman Coulter Service Engineer.

444 LED power is low. Contact a Beckman Coulter Service Engineer.
445 LED power overflow. Contact a Beckman Coulter Service Engineer.
446 No LED installed. Contact a Beckman Coulter Service Engineer.
450 No temperature installed. Check instrument configuration.
451 Temperature setpoint exceeds maximum valid 

setpoint.
Decrease the temperature setting (refer to 
Section 2.3.3.1, Temperature Control (880 
only)).

452 Temperature sensor is not responding. Check the current temperature setting (refer to 
Section 2.3.3.1, Temperature Control (880 
only)).

453 Temperature sensor not found Decrease the temperature setting (refer to 
Section 2.3.3.1, Temperature Control (880 
only)).

Table A-1.  Software Error Codes and Solutions
Error
Code

Error Message Recommended Solution
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